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Safety

This chapter includes:
• Electrical Safety on page 10
• Operational Safety on page 12
• Maintenance Safety on page 14
• Printer Symbols on page 15

Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your 
printer.
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Electrical Safety

General Guidelines
Warning: Do not push objects (including paper clips or staples) into slots or openings on the 
printer. Making contact with a voltage point or shorting out a part could result in fire or electrical 
shock.

Warning: Do not remove the covers or guards that are fastened with screws unless you are 
installing optional equipment and are specifically instructed to do so. Power should be OFF when 
performing these installations. Disconnect the power cord when removing covers and guards for 
installing optional equipment. Except for user-installable options, there are no parts that you can 
maintain or service behind these covers.

Note: Leave the printer on for optimum performance; it does not pose a safety hazard. If, however, 
the printer will not be used over an extended period of time, it should be turned off and unplugged.

The following are hazards to your safety:
• The power cord is damaged or frayed.
• Liquid is spilled into the printer.
• The printer is exposed to water.

If any of these conditions occur, do the following:
1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Laser Safety

This printer complies with laser printer performance standards set by governmental, national, and 
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous 
light because the beam is totally enclosed during all modes of customer operation and maintenance.

Warning: Use of controls, adjustments, or performance of procedures other than those specified in 
this manual can result in hazardous radiation exposure.

Power Cord
• Use the power cord supplied with your printer.
• Plug the power cord directly into a properly-grounded electrical outlet. Make sure each end of the 

cord is securely connected. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet.

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have 
a ground connection terminal.

• Only use an extension cord or power strip designed to handle the electrical current capacity of the 
printer.
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• Verify that the printer is plugged into an outlet that is capable of providing the correct voltage and 
power. Review the printer’s electrical specification with an electrician if necessary.

Warning: Avoid the potential of electrical shock by ensuring that the printer is properly grounded. 
Electrical products may be hazardous if misused.

• Do not place the printer in an area where people might step on the power cord.
• Do not place objects on the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.
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Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. Your 
attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer.

Operational Guidelines
• Do not remove the paper source tray that you selected in either the printer driver or the control 

panel, when the printer is printing.
• Do not open the doors when the printer is printing.
• Do not move the printer when it is printing.
• Keep hands, hair, neckties, etc., away from the exit and feed rollers.

Ozone Release

During print operation, a small quantity of ozone is released. This amount is not large enough to harm 
anyone adversely. However, be sure the room where the printer is being used has adequate ventilation, 
especially if you are printing a high volume of materials, or if the printer is being used continuously 
over a long period.

Printer Location
• Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer.
• Place the printer in a dust-free area where there is adequate space for operation and servicing. For 

details, see Choosing a Location for the Printer on page 31.
• Do not store or operate the printer in an extremely hot, cold, or humid environment. For 

specifications on optimum performance environment, see Environmental Specifications on 
page 155.

• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight 
of the printer. The base printer weight without any packaging materials is approximately 18.4 kg 
(40.57 lb.).

• Do not place the printer near a heat source.
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

unit.
• Do not place the printer in locations susceptible to vibrations.
• For optimum performance, use the printer at elevations below 3,000 m (11,480 ft.).
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Printer Supplies
• Use the supplies specifically designed for your printer. The use of unsuitable materials may cause 

poor performance and a possible safety hazard.
• Follow all warnings and instructions marked on, or supplied with, the printer, options, and supplies.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreements, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of 
performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this 
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage 
may vary outside these areas; please contact your local representative for details.
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Maintenance Safety

• Do not attempt any maintenance procedure that is not specifically described in the 
documentation supplied with your printer.

• Do not use aerosol cleaners. Clean with a dry, lint-free cloth only.
• Do not burn any consumables or routine maintenance items. For information on Xerox supplies 

recycling programs, go to www.xerox.com/gwa.

See also: 
Cleaning the Printer on page 112
Moving the Printer on page 123

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=recyclesupplies&Language=english
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Printer Symbols

The following safety symbols are marked on the printer.

Symbol Description

Warning or Caution:
Ignoring this warning could cause serious injury or even death.
Ignoring this caution could cause injury or damage to the property.

Hot surface on or in the printer. Use caution to avoid personal injury.

Do not touch components with this symbol as personal injury could result.

Do not expose the item to light.

Do not burn.

It may take 40 minutes for the fuser to cool down.

6140-040
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Features

This chapter includes:
• Main Components and Their Functions on page 18
• Configurations and Options on page 22
• Power Saver Mode on page 24
• Information Pages on page 25
• CentreWare Internet Services on page 26
• More Information on page 27
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Main Components and Their Functions

This section includes:
• Front View on page 18
• Rear View on page 19
• Internal Components on page 20
• Control Panel on page 21

Front View

Phaser 6140 printer (with optional 250-sheet feeder)

1. Control panel

2. Front cover

3. Button for opening the front cover and for releasing the duplex unit.

4. Manual feed slot

5. Paper tray (Tray 1 if optional 250-sheet feeder is installed).

6. Optional 250-sheet feeder (Tray 2)

7. Output tray

8. Toner cartridges

6140-001

1

7

2

4

5

6

8

3



Features

Phaser 6140 Color Laser Printer
User Guide

19

Rear View

1. Optional memory slot

2. Network connector

3. USB port

4. Power cord connector

5. Power switch

6140-002
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Internal Components

Phaser 6140/DN

1. Fuser 

2. Imaging unit

3. Button for opening the front cover and releasing the duplex unit.

4. Duplex unit

5. Transfer belt unit (with Tray 1 removed so the transfer belt unit folds down completely).

6140-003
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Control Panel

The control panel displays two screen types:
• Print screens, for displaying printer status.
• Menu screens, for configuring settings.

1. Menu Display window
Displays status messages, 
menus, and toner levels.

2. Menu button
Scrolls to the menu option. 
Switches the display between 
the menus and the print 
screen.

3. OK button
Selects the displayed menu 
option and also prints reports 
and lists.

4. Wake Up / Power Saver 
button
Stays lit in Power Save mode. 
Press to exit Power Save mode 
and “wake up” the printer 
when in sleep mode. When 
printer is idle, press to 
manually put the printer in 
sleep mode.

5. Cancel Job button
Cancels the current print job.

6. Navigation / Menu select 
buttons
Up / Down Arrow buttons:
Press to scroll up and down 
through the menu display.
Back / Forward Arrow buttons:
Press to move left and right 
through the menu display. 
Back Arrow button:
Press to back out of a menu 
level. Press to display the Walk-
Up Features menu.

7. Error Indicator light
Lights up to indicate an error 
condition or warning that can 
be resolved by the user.
Blinks when an error occurs 
that cannot be resolved by the 
user.
Off when the printer is 
operating properly.

8. Ready Indicator light
Lights up when the printer is 
ready to receive data.
Blinks when the printer is busy 
receiving data.
Off when an error occurs or 
when the printer is in Power 
Saver mode.

6140-004

Phaser 6140

1 2 3

4

5678



Features

Phaser 6140 Color Laser Printer
User Guide

22

Configurations and Options

This section includes:
• Configurations on page 22
• Standard Features on page 22
• Additional Capabilities on page 22
• Optional Features on page 23

Configurations

The Phaser 6140 printer is available in two configurations:
• Phaser 6140/N: All standard features listed below in the Standard Features section.
• Phaser 6140/DN: All standard features listed below plus a duplex unit.

Note: You can order additional memory, trays, and the duplex unit (for automatic 2-sided printing) 
if these items are not standard on your printer.

Standard Features

All configurations of the Phaser 6140 printer come with the following features:
• 250-sheet tray (Tray 1)
• Single-sheet manual feed slot
• 256 MB Memory (RAM)

Note: All printer configurations have one memory slot supporting 256 MB, 512 MB, 768 MB, or 
1024 MB DDR2 DIMMs, to a maximum of 1280 MB (256 MB standard + 1024 MB optional).

• 10Base-T/100Base-TX Ethernet interface (Network connection)
• USB 2.0 connection
• Power Saver Mode
• PrintingScout printer monitoring utility (Windows only)
• Printer information pages (Menu Map, Configuration Page, Demo Page)
• Billing meters
• Admin menu with control panel lock

Additional Capabilities

These features are built in to the printer but require additional memory to function. You can purchase 
additional memory. For details, see Optional Features on page 23.
• Walk-Up Printing: Printing a stored print job directly from the printer control panel.
• RAM Disk: Allocates memory to the RAM Disk file system for Collation, Secure Print, Proof Print, 

Form Overlay, and Font Download.
• Collation: Allows jobs to be stored in memory so that multiple copies can be printed in page 

sequence order: 123, 123, 123, 123, instead of 1111, 2222, 3333.
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• Secure Print: Data can be stored in memory and require a password to be printed.
• Proof Print: Multiple copies can be stored in memory but allow you to print only the first set to 

check the print results. If satisfactory, the rest can be printed from the printer control panel.
• Form Overlay: Enables writing PCL5 forms.
• Font Download: Enables the downloading of fonts to the RAM Disk.

Optional Features

You can purchase equipment for the following features:
• Duplex unit for automatic 2-sided printing (optional for Phaser 6140/N).
• 250-sheet feeder (Tray 2)
• Wireless LAN
• 512 MB / 1024 MB memory upgrade

See also: 
Printer Specifications on page 153
Enabling Optional Features on page 44
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Power Saver Mode

This section includes:
• Setting the Power Saver Time on page 24
• Exiting Power Saver Mode on page 24
• Starting Power Saver Mode on page 24

The printer is equipped with a Power Saver mode to reduce power consumption when it is left idle for a 
specified period of time. When no print data is received for the duration set in the Power Saver Time, 
(30 minutes is the default), the printer enters Power Saver mode. Time ranges from 5 minutes to 60 
minutes can be specified, in one-minute increments. Power consumption during Power Saver mode is 8 
W or less, and the time required to exit from Power Saver mode to a print-ready status is about 20 
seconds.

Setting the Power Saver Time
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. Arrow down to System Setup and then press OK.
4. At Power Saver Time, press OK.
• Do one of the following:

• To increase the amount of time, press the Up Arrow button until the desired time is reached 
(maximum is 60 minutes).

• To decrease the amount of time, press the Down Arrow button until the desired time is 
reached (minimum is 5 minutes).

5. Press OK.

Exiting Power Saver Mode

The printer automatically cancels Power Saver mode when it receives data from a connected computer. 
However, you can cancel Power Saver mode by pressing the Wake Up button on the printer control 
panel. For an illustration showing the location of the Wake Up button, see Control Panel on page 21.

Starting Power Saver Mode

If you will not be using the printer for a while and want to switch into Power Saver mode without 
having to wait for it to do so automatically from the default settings, press the Wake Up button on the 
printer control panel. The printer must currently be idle and have been idle for at least one minute 
when you press the Wake Up button. If the printer is receiving data, or is calibrating after having been 
in Power Saver mode or having been restarted after a cleared jam, or if you have pressed another 
button within the last minute, it will not go into Power Saver mode.
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Information Pages

This section includes:
• Menu Map on page 25
• Configuration Page on page 25

Your printer comes with a set of information pages to help you track the printer’s performance and 
diagnose problems so you can obtain the best results from your printer. You access these pages from 
the printer control panel. Listed below are the two most commonly used information pages. For a 
complete list and explanation of printer information pages, see Information Pages Menu on page 97.

Menu Map

The Menu Map lists all main and second-level menu headings that you can use to help you navigate 
the printer control panel menus. The Menu Map also lists other information pages available for 
printing.

To print the Menu Map:
1. On the printer control panel, press the Menu button.
2. At Information Pgs, press the OK button.
3. At Menu Map, press OK.

Configuration Page

This page lists printer information such as default printer settings, installed options, network settings 
(IP address, for example), and font settings. Use the information on this page to help you configure 
network settings for your printer, and to see page counts and system settings.

Note: By default, the Configuration page prints automatically each time the printer is turned on. 
You can disable this feature in the System Setup Menu under the Admin Menu settings. For details, 
see System Setup Menu on page 101.

To print the Configuration page:
1. On the printer control panel, press the Menu button.
2. At Information Pgs, press the OK button.
3. Press the Down Arrow button to go to Configuration and then press OK to print.
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CentreWare Internet Services

Note: This section applies to Phaser 6140/N or Phaser 6140/DN printer configurations connected 
to a network.

CentreWare Internet Services (CentreWare IS) enables you to easily manage, configure, and monitor a 
network printer using a Web browser on a network computer. CentreWare IS gives you access to printer 
status, configuration, security settings, diagnostic functions, and more. 

To access CentreWare IS, first make sure your printer is turned on, then enter your printer’s IP address 
in your computer’s Web browser. For details, see Finding Your Printer’s IP Address on page 37.

CentreWare IS enables you to:
• Configure the printer, email, and network settings from your computer.
• See printer information such as serial number, memory, and installed options.
• Check supplies status from your desktop, saving a trip to the printer.
• View a usage summary.

Note: CentreWare IS requires a Web browser and a TCP/IP connection between the printer and the 
network (in Windows or Macintosh environments). TCP/IP and HTTP must be enabled in the 
printer, and a browser that supports JavaScript is required. If JavaScript is disabled, a warning 
message appears and CentreWare IS may not function properly.
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More Information

The following links provide more information about your printer and its capabilities.

Information Source

Installation Guide Packaged with printer.

Quick Use Guide Packaged with printer.

User Guide (PDF) Software and Documentation CD

Video Tutorials www.xerox.com/office/6140docs

Recommended Media List Europe: www.xerox.com/europaper
North America: www.xerox.com/paper

Online Support Assistant www.xerox.com/office/6140support

Technical Support www.xerox.com/office/6140support

Information pages Print from the control panel menu.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=rmleu&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=knowledgebase&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=man&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udcwishelp&Page=color&Model=Phaser+6140&PgName=rmlna&Language=english 
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Installation and Setup

This chapter includes:
• Installation and Setup Overview on page 30
• Choosing a Location for the Printer on page 31
• Connecting the Printer on page 32
• Configuring Network Settings on page 34
• Installing the Printer Drivers on page 38
• Installing PrintingScout on page 43
• Enabling Optional Features on page 44

See also: 
Online Support Assistant at www.xerox.com/office/6140support

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=knowledgebase&Language=english
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Installation and Setup Overview

Before using the printer, you must:
1. Make sure the printer is set up correctly in an appropriate location. For details, see Choosing a 

Location for the Printer on page 31.
2. Select a connection method. For details, see Choosing a Connection Method on page 32.
3. Make sure the printer is connected correctly. For details, see Connecting the Printer on page 32.
4. Turn on the printer and the computer. The printer’s Configuration page should print by default. If it 

does not, see Configuration Page on page 25. If you are connected to a network, keep the 
Configuration page for referencing network settings such as your printer’s IP address.

5. If connected to a network, configure network settings. For details, see Configuring Network 
Settings on page 34.

6. Install drivers and software utilities from the Software and Documentation CD. The software 
installation procedure used depends on your connection type (network or USB). For details, see 
Installing the Printer Drivers on page 38.

Note: If the Software and Documentation CD is not available, you can download the latest drivers 
from www.xerox.com/office/6140drivers.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=driver&Language=english
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Choosing a Location for the Printer

1. Select a dust-free area with temperatures between 10°–32°C (50°–90°F), and relative humidity 
between 15–85%.

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of 
the printer. The printer should be horizontal with all four feet in solid contact with the surface. The 
printer weight, without the options or paper, is 18.4 kg (40.57 lb.). With the 250-sheet feeder, the 
duplex unit, and consumables, the weight is 23.8 kg (52.47 lb.).

3. Ensure your printer has the proper amount of clearance for all of its features, including any options 
you purchased. See the following measurements.
The recommended minimal spacing for the printer is:
Overhead Clearance:
200 mm (7.9 in.) above the printer for clearance when opening the front door
Height Requirement:
• Printer: 415 mm (16.3 in.)
• With 250-sheet feeder: add 108 mm (4.25 in.)
Other Clearances:
• 100 mm (3.9 in.) behind the printer
• 600 mm (23.6 in.) in front of the printer
• 100 mm (3.9 in.) on the left side of the printer
• 250 mm (9.8 in.) on the right side of the printer

4. After positioning the printer, you are ready to connect it to the power source and computer or 
network. Go to the next section, Connecting the Printer on page 32.
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Connecting the Printer

This section includes:
• Choosing a Connection Method on page 32
• Connecting via a Network on page 32
• Connecting via USB on page 33

Choosing a Connection Method

The printer can be connected to your computer via a USB cable or an Ethernet cable. The method you 
choose depends on whether or not your computer is connected to a network. A USB connection is a 
direct connection, is not used for networking, and is the easiest to set up. An Ethernet connection is 
used for networking. There are many ways that printers and computers can be connected on a 
network, so if you are going to use a network connection, you will need to know how your computer is 
connected to your network (for example, via a router connected to a cable or DSL modem). For more 
information, see About TCP/IP and IP Addresses on page 34.

Note: Hardware and cabling requirements vary for the different connection methods. Routers, 
network hubs, network switches, modems, Ethernet and USB cables are not included with your 
printer and must be purchased separately.

• Network: If your computer is connected to an office network or a home network (whether a hard 
connection or wireless), you will use an Ethernet cable to connect the printer to the network instead 
of directly to the computer. An Ethernet network can be used for one or more computers and 
supports many printers and systems simultaneously. An Ethernet connection is recommended 
because it is faster than a USB connection and it allows you direct access to the printer’s settings 
via CentreWare IS.

• USB: If you are connecting the printer to one computer and do not have a network, you will use a 
USB connection. While a USB connection offers fast data speeds, it is not as fast as an Ethernet 
connection and does not provide access to CentreWare IS. To use USB, PC users must have 
Windows 2000/XP/Server 2003 or newer. Macintosh users must use Mac OS X, version 10.3 and 
higher.

Connecting via a Network

To connect the printer to a network:
1. Make sure the printer is turned off.
2. Attach an Ethernet RJ-45 cable from the printer to the network or router socket. You will need an 

Ethernet hub, or a DSL or Cable router (direct or wireless), and two or more twisted-pair Ethernet 
RJ-45 cables (one cable for each device). To connect using an Ethernet hub or router, first connect 
the computer to the hub/router with one cable and then connect the printer to the hub/router with 
the second cable. Connect to any port on the hub/router except the uplink port.

3. Attach the power cord and then plug in the printer and turn it on. For safety information, see Power 
Cord on page 10.

4. You will need to manually set or automatically discover the printer’s IP (network) address. Go to 
Assigning the Printer’s IP Address on page 34.
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Connecting via USB

To use USB, PC users must have Windows 2000/XP/Server 2003 or newer. Macintosh users must use 
Mac OS X, version 10.3 and higher.

To connect the printer to the computer via USB cable:
1. Make sure the printer is turned off.
2. Connect one end of a standard A/B USB 2.0 cable to the printer’s USB port.
3. Attach the power cord and then plug in the printer and turn it on. For safety information, see Power 

Cord on page 10.
4. Connect the other end of the USB cable to the computer’s USB port.
5. When the Windows Found New Hardware Wizard appears, cancel it.
6. You are ready to install the printer drivers. Go to Installing the Printer Drivers on page 38.
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Configuring Network Settings

This section includes:
• About TCP/IP and IP Addresses on page 34
• Assigning the Printer’s IP Address on page 34
• Changing the IP Address Using CentreWare IS on page 36
• Finding Your Printer’s IP Address on page 37

Note: These instructions apply to the printer when it is connected to a network. If you have a USB 
connection to the printer, you can skip this section.

About TCP/IP and IP Addresses

PCs and printers primarily use TCP/IP protocols to communicate over an Ethernet network. Generally, 
Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a network 
printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does not 
require printers or computers to have IP addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and 
Cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically assigns an IP address to every PC and printer on the network that is configured to use 
DHCP.

If you use a Cable or DSL router, see your router’s documentation for information on IP addressing.

Assigning the Printer’s IP Address

This section includes:
• Allowing the IP Address to be Assigned Automatically on page 35
• Assigning the IP Address Manually on page 35
• Changing the IP Address Using CentreWare IS on page 36

By default, the printer is set to be automatically recognized by the network, acquiring an IP address 
using DHCP. Network addresses assigned by DHCP are temporary, however. After a specified time, the 
network may assign a new IP address to the printer. This may cause a connectivity problem if the 
printer driver is set to an IP address that changes periodically. If this becomes a problem for you, or if 
your network administrator requires a static IP address for the printer, you can assign the IP address to 
the printer manually. For details, see Assigning the IP Address Manually on page 35.

Note: You can view your printer’s IP address from either the Configuration page or the printer 
control panel. For details, see Finding Your Printer’s IP Address on page 37.
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Allowing the IP Address to be Assigned Automatically

If you have specified a static IP address and at some point want to re-enable automatic assigning of 
the printer’s IP address, you can do this from the printer control panel.
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. At Network Setup, press OK.
4. Arrow down to TCP/IP and press OK.
5. Arrow down to IPv4 and press OK.
6. At Get IP Address, press OK.
7. Arrow down to DHCP/AutoIP and press OK.

Assigning the IP Address Manually

These instructions are for assigning a static IP address to your printer from the printer’s control panel. 
Once an IP address is assigned, you can change it using CentreWare IS.

To assign a static IP address to the printer:
1. You will need the following information to assign the IP address:

• An IP address properly configured for your network.
• The Network Mask address
• The default Router/Gateway address
If you are on a network managed by a network administrator, contact your network administrator 
to obtain the network information.
If you are on a home network that uses a router or other device to connect the printer to the 
network, refer to the router/device documentation for instructions on assigning network addresses. 
The router/device documentation should give you a range of acceptable address numbers you can 
use. It is important that the addresses be similar to those used by other printers and computers on 
the network, but not the same; only the last digit needs to be different. For example, your printer 
can have the IP address 192.168.1.2 while your computer has the IP address 192.168.1.3. Another 
device can have the IP address 192.168.1.4.

Note: To reduce the chance of the router assigning the printer’s static IP address to another 
computer that obtains its IP address dynamically, give the printer an address at the higher end of 
the address range allowed by the router/device. For example, if your computer has the IP address 
192.168.1.2, and your router/device allows IP addresses up to 192.168.1.25, select an IP address 
between 192.168.1.20 and 192.168.1.25.

2. On the printer control panel, press the Menu button.
3. Press the Down Arrow button to go to Admin Menu and then press the OK button.
4. At Network Setup, press OK.
5. Arrow down to TCP/IP and press OK.
6. Arrow down to IPv4 and press OK.
7. At Get IP Address, press OK.
8. Arrow down to Panel and press OK to enable this option.
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9. Press the Back Arrow button once to return to the IPv4 menu and then arrow down to IP Address 
and press OK.
You use the Up, Down, Back and Forward Arrow buttons to select the IP address. When undefined, 
the address is 000.000.000.000. Beginning with the first bank of numbers, use the following 
method to select the IP address:

10. Press the Up Arrow button to scroll through the numbers until you reach the desired number, then 
press the Forward Arrow button once to go to the next bank of numbers. Repeat the process: press 
the Up Arrow button until you reach the desired number, then press the Forward Arrow button 
once to move to the next bank, etc. To scroll down through the numbers, press the Down Arrow 
button. To scroll quickly to a high number, hold down the arrow button. To go back to a bank of 
numbers, press the Back Arrow button.

11. When finished, press OK to confirm the address.
12. Press the Back Arrow button once and then press the Down Arrow button to go to Network Mask 

and then press OK. Repeat steps 10 and 11 to select the Network Mask address.
13. Press the Back Arrow button once and then press the Down Arrow button to go to Gateway 

Address and then press OK. Repeat steps 10 and 11 to select the Gateway Address.
14. Print the Configuration page to verify the new settings. For details, see Configuration Page on 

page 25.
15. You are ready to install software. Go to Installing the Printer Drivers on page 38.

See also: 
Online Support Assistant at www.xerox.com/office/6140support

Changing the IP Address Using CentreWare IS

To change the printer’s IP address using CentreWare IS:
1. Launch your computer’s Web browser and then type the printer’s IP address into the browser’s 

Address field using this format: http://xxx.xxx.xxx. Type the address separating the groups of 
numbers by periods. If the address only has two numbers in a group instead of three, then enter 
only those two numbers; do not enter a zero as a placeholder.

2. On the right side of the page, click the Properties button.
3. In the navigation pane on the left of the page, expand the Protocols link if it is not already 

expanded, then click TCP/IP.
4. The TCP/IP - IPv4 page opens. In the middle box, make the desired changes. For example, to 

change the way the printer acquires the IP address, in the Get IP Address field, select a method 
from the drop-down list.

5. When done making changes, scroll to the bottom of the page and click the Save Changes button.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=knowledgebase&Language=english
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Finding Your Printer’s IP Address

To access your printer’s settings from CentreWare IS, and to install the printer drivers for a network-
connected printer, you need to know your printer’s IP address. The printer’s IP address is printed on the 
Configuration page and can be displayed on the printer control panel.

To print the Configuration page:
1. On the printer control panel, press the Menu button.
2. At Information Pgs, press the OK button.
3. Press the Down Arrow button to go to Configuration and then press OK.

The printer’s IP address is listed in the Network Setup section of the page.

Note: The first time you plug in your printer, it will automatically print the Configuration page. If 
the IP address listed on the page is 0.0.0.0, the printer has not had time to acquire an IP address 
from the DHCP server. Wait a minute or two and then print the Configuration page again.

To get the printer’s IP address from the printer control panel:
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. At Network Setup, press OK.
4. Arrow down to TCP/IP and press OK.
5. Arrow down to IPv4 and press OK.
6. Arrow down to IP Address and press OK.

The printer’s IP address is displayed.
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Installing the Printer Drivers

This section includes:
• Operating System Requirements on page 38
• Available Drivers on page 38
• Installing the Printer Drivers for Windows on page 39
• Installing the Printer Driver for Macintosh OS X on page 39
• Adding the Printer for Macintosh on page 40

Operating System Requirements
• PC: Windows 2000/2003 server / XP pro / XP / Vista
• Macintosh: OS version 10.3.9 to 10.5
• Linux/UNIX: Red Hat / SuSe / TurboLinux 10 Desktop

Available Drivers

To access special printing options, use a Xerox printer driver. Xerox provides drivers for a variety of page 
description languages and operating systems. The following printer drivers are available. The software 
CD listed in the Source column refers to the Software and Documentation CD that came packaged with 
your printer. The website from which you can download drivers is www.xerox.com/office/6140drivers.

Printer Driver Source Description

Adobe PostScript 3 Driver Software CD 
and Web

The PostScript driver is recommended to take full 
advantage of your system's custom features and 
genuine Adobe PostScript. (Default printer 
driver.)

PCL6 Software CD 
and Web

The Printer Command Language driver can be 
used for applications requiring PCL.

Mac OS X (version 10.3 and higher) 
Driver

Software CD 
and Web

This driver enables printing from a Mac OS X 
(version 10.3 and higher) operating system.

UNIX Web only This driver enables printing from a UNIX 
operating system.

Linux Software CD This driver enables printing from a Linux 
operating system.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=driver&Language=english
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Installing the Printer Drivers for Windows

To install the printer driver from the Software and Documentation CD:
1. Insert the CD into your computer’s CD drive. If the installer does not start automatically, navigate 

to your computer’s CD drive and double-click the Setup.exe installer file.
2. At the bottom of the installer screen, click the Language button, select your language, then click 

OK.
3. Click Install Print Driver.
4. At the License Agreement screen, click I Agree to accept the license agreement. The Xerox Printer 

Installation screen appears.
5. In the Discovered Printers list, select your Phaser 6140 printer and then click Next.

Note: If you are installing drivers for a network-connected printer and you do not see your printer 
displayed in the list, click the IP Address or DNS Name button on the right. In the IP Address or 
DNS Name field, type your printer’s IP address and then click Search to locate your printer. If you 
do not have your printer’s IP address, see Finding Your Printer’s IP Address on page 37.

6. In the Installation Options screen, select PostScript and/or PCL 6.

Note: You can install both drivers at once. Each will be displayed in your printer list after 
installation.

7. Click Install to start the installation.
8. When the installation is complete, at the Installation Status screen, select the following:

• Set Printer As Default (optional)
• Print a Test Page
• Share Printer (optional)

9. Click Finish.
10. At the Product Registration screen, select your country from the list and then click Next. Complete 

the registration form and submit it.
If you selected to print a test page, the printer prints a test page for each driver you installed.

Note: PrintingScout is a separate option from the printer driver. To install PrintingScout, go to 
Installing PrintingScout on page 43.

See also: 
Online Support Assistant at www.xerox.com/office/6140support

Installing the Printer Driver for Macintosh OS X

The installation process for Macintosh OS X is the same for versions 10.3, 10.4, and 10.5.

To install the printer driver from the Software and Documentation CD:
1. Insert the Software and Documentation CD into your computer’s CD drive.
2. On your desktop, double-click the Phaser 6140 icon.
3. Click Phaser 6140 Installer.
4. If prompted to enter your password, do so and then click OK.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=knowledgebase&Language=english
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5. At the Introduction installer window, click Continue.
6. Read the license agreement, click Continue and then click Agree.
7. Click Install.

When the driver is finished installing, your browser opens to an online registration form.
8. Complete the online registration and then close the browser.
9. At the Finish Up window, click Quit.
10. Next, add the printer to your printer queue. For details, see Adding the Printer for Macintosh on 

page 40.

Adding the Printer for Macintosh

This section includes:
• Adding the Printer: OS X Version 10.3 on page 40
• Adding the Printer: OS X Version 10.3 LPR (IP Address) Connection on page 41
• Adding the Printer: OS X Version 10.4 on page 41
• Adding the Printer: OS X Version 10.4 LPD (IP Address) Connection on page 41
• Adding the Printer: OS X Version 10.5 on page 42

For networking, you can set up your printer using Bonjour (Rendezvous), or connect using your printer’s 
IP address for an LPD/LPR connection for Macintosh OS X, version 10.3 and higher. For a non-network 
printer, create a desktop USB connection.

See also: 
Online Support Assistant at www.xerox.com/office/6140support

Adding the Printer: OS X Version 10.3
1. Do one of the following:

• Open the Applications folder and then open the Utilities folder. Open the Printer Setup 
Utility.

• From the dock, click the Printer Setup Utility.
2. In the top row of the window, click the Add icon.
3. Do one of the following:

• If your computer has a network connection to the printer, confirm that the first drop-down 
menu is set to Rendezvous.

• If your computer has a USB connection to the printer, confirm that the first drop-down menu is 
set to USB.

4. In the window, select your printer.
5. From the Printer Model drop-down list, select Xerox.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=knowledgebase&Language=english
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6. Select your printer model from the list of Xerox printers and then click Add.

Note: If your printer was not detected, verify that the printer is on and that the Ethernet or USB 
cable is connected properly. If you have verified that the printer is on and connected correctly and 
you are using an Ethernet cable to connect to a network, try adding the printer using the IP 
address. See the following set of instructions for details.

Adding the Printer: OS X Version 10.3 LPR (IP Address) Connection
1. Open the Printer Setup Utility for Mac OS X, version 10.3.
2. Click the Add button.
3. From the Printer Browser menu, select IP Printing.
4. From the second pull-down menu, select LPD/LPR.
5. In the Printer Address field, enter the printer’s IP address. To find your printer’s IP address, see 

Finding Your Printer’s IP Address on page 37.
6. Verify that the Queue Name field is blank.
7. Select Xerox from the Printer Model pull-down menu and then select the corresponding PPD file 

with your printer name, either Xerox Phaser 6140DN PS or Xerox Phaser 6140N PS.
8. Click the Add button. The printer is added to the list.

Adding the Printer: OS X Version 10.4
1. Open the Applications folder and then open System Preferences.
2. Open Print & Fax and then select the Printing tab.
3. Click the plus button (+) below the list of printers.
4. In the top row of the window, click the Default icon.
5. In the list of printers, select your printer and then click Add.

Note: If your printer was not detected, verify that the printer is on and that the Ethernet or USB 
cable is connected properly.

Adding the Printer: OS X Version 10.4 LPD (IP Address) Connection
1. Click the Apple menu and select System Preferences and then select Print and Fax.
2. Click the plus button (+) below the list of printers.
3. Click the Add Printer button.
4. From the drop-down menu, select IP Printing.
5. In the Address field, enter the printer’s IP address.
6. Verify that the Queue field is blank.
7. Click Print Using and then select Xerox from the Printer Model menu. Select the corresponding PPD 

file for your printer.
8. Click the Add button. The printer is added to the list.
9. Close the Print and Fax window.
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Adding the Printer: OS X Version 10.5
1. From the Applications folder or from the dock, open System Preferences.
2. Open Print & Fax. The list of printers appears on the left of the window.
3. Click the plus (+) button under the list of printers.
4. Click the Default icon at the top of the window.
5. Select your printer from the list and click Add.

Note: If your printer was not detected, verify that the printer is on and that the Ethernet or USB 
cable is connected properly.
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Installing PrintingScout

Note: PrintingScout is a Windows-only utility.

The PrintingScout utility enables you to monitor the status of print jobs and printer supplies from your 
computer. It automatically checks the printer status when you send a print job. If the printer is unable 
to print your job, PrintingScout automatically displays an alert on your computer screen to let you 
know that the printer needs attention.
1. Insert the Software and Documentation CD into your computer’s CD drive. If the installer does not 

start automatically, navigate to your computer’s CD drive and double-click the Setup.exe installer 
file.

2. At the installer screen, click Install PrintingScout.
3. In the Choose Setup Language window, select your language and then click Next.
4. At the Xerox PrintingScout screen, click Next.
5. Read the license agreement and then click I accept the terms of the license agreement. Click 

Next.
6. At the next screen, accept the default installation destination by clicking Next.
7. Click Next.
8. Click Finish.

The PrintingScout icon appears on the right in your Window’s Taskbar.

See also: 
Checking Printer Status with PrintingScout on page 117



Installation and Setup

Phaser 6140 Color Laser Printer
User Guide

44

Enabling Optional Features

This section includes:
• Enabling Optional Features for the Windows PostScript Driver on page 44
• Enabling Optional Features for Macintosh on page 46
• Enabling Optional Features for Linux on page 47

If your printer includes the duplex unit (Phaser 6140/DN printer configuration), 250-sheet feeder, RAM 
Disk, or extra memory, you must enable these options in each printer driver before you can use these 
features.

Enabling Optional Features for the Windows PostScript Driver 

This section includes:
• Enabling Optional Features for a Network-Connected Printer on page 44
• Enabling Optional Features for a USB Cable-Connected Printer on page 44

Enabling Optional Features for a Network-Connected Printer
1. Navigate to your computer’s list of printers:

• For Windows XP, click Start > Settings > Printers and Faxes.
• For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
• For Windows 2000 and Windows Server 2003, click Start > Settings > Printers.
• For Windows Server 2008, click Start > Settings > Printers.

2. In the list of printers, right-click the Phaser 6140 PS printer and select Properties.
3. Click the Configuration tab and then click the Get Information from Printer button.

The printer’s IP address should appear in the Network Address section.
4. Click Apply.
5. You can verify that the installed optional features have been enabled: click the Device Settings tab 

and then scroll down to view the Installable Options section.
6. Click OK to close the Properties dialog box.

Enabling Optional Features for a USB Cable-Connected Printer
1. Navigate to your computer’s list of printers:

• For Windows XP, click Start > Settings > Printers and Faxes.
• For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
• For Windows 2000 and Windows Server 2003, click Start > Settings > Printers.
• For Windows Server 2008, click Start > Settings > Printers.

2. In the list of printers, right-click the Phaser 6140 PS printer and select Properties.
3. In the Properties dialog box, click the Device Settings tab.
4. Click the plus sign (+) to the left of Installable Options to expand and see the list of optional 

features.
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5. Enable the installed features:
• To specify the amount of RAM memory available, click Memory and then select the amount of 

memory from the drop-down list.
• To enable the 250-sheet feeder, click Paper Tray Configuration and select 2-Tray from the 

drop-down list.
• If you have enough memory to use the RAM Disk feature (minimum of 512 MB required), click 

RAM Disk and select Available from the drop-down list.
• To enable the duplex unit, click Duplex Unit and select Available from the drop-down list.

6. Click OK.

Enabling Optional Features for the Windows PCL Driver

This section includes:
• Enabling Optional Features for a Network-Connected Printer on page 44
• Enabling Optional Features for a USB Cable-Connected Printer on page 44

Enabling Optional Features for a Network-Connected Printer
1. Navigate to your computer’s list of printers:

• For Windows XP, click Start > Settings > Printers and Faxes.
• For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
• For Windows 2000 and Windows Server 2003, click Start > Settings > Printers.
• For Windows Server 2008, click Start > Settings > Printers.

2. In the list of printers, right-click the Phaser 6140 PCL printer and select Properties.
3. In the Properties dialog box, click the Options tab.
4. Click the Get Information from Printer button.

The printer’s IP address should appear in the Network Address section, the installed optional 
features should be listed as Available in the Items list, and the amount of memory installed should 
appear in the Memory Capacity field.

5. Click OK.

Enabling Optional Features for a USB Cable-Connected Printer
1. Navigate to your computer’s list of printers:

• For Windows XP, click Start > Settings > Printers and Faxes.
• For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
• For Windows 2000 and Windows Server 2003, click Start > Settings > Printers.
• For Windows Server 2008, click Start > Settings > Printers.

2. In the list of printers, right-click the Phaser 6140 PCL printer and select Properties.
3. In the Properties dialog box, click the Options tab.

The Items box lists the printer options. To the right of each item is the status, either Available or 
Not Available, or in the case of Memory Capacity, the amount of RAM in MB.
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4. To enable the items that are installed in your printer, select the item in the list and then, in the 
Settings for: drop-down list, select Available. If you are enabling additional memory, then in 
Memory Capacity, select the amount of RAM in MB from the list.

5. Click OK.

Enabling Optional Features for Macintosh

This section includes:
• Enabling Optional Features for Macintosh OS X Version 10.3 on page 46
• Enabling Optional Features for Macintosh OS X Versions 10.4 and 10.5 on page 46

Enabling Optional Features for Macintosh OS X Version 10.3
1. From the Applications folder or from the dock, open System Preferences.
2. Open Print & Fax. The list of printers appears on the left of the window.
3. In the Printer list, select your printer and then click the Show Info icon in the top row of the 

window.
4. In the Printer Info window, from the first drop-down list, select Installable Options.
5. Select all that apply:

• If you have added the optional additional memory, select the amount of total memory from 
the Memory list.

• If you have the optional 250-sheet feeder installed (Tray 2), then select 2-Tray from the Paper 
Tray Configuration list.

• If you have enough memory to use the RAM Disk function (minimum 512 MB required), select 
the RAM Disk check box.

• If the duplex unit is installed, select the Duplex Unit check box.
6. Click the Apply Changes button.
7. Close the window.

Enabling Optional Features for Macintosh OS X Versions 10.4 and 10.5

These instructions apply to Macintosh OS X version 10.5. If your version of OS X is 10.4, the steps may 
vary slightly.
1. From the Applications folder or from the dock, open System Preferences.
2. Open Print & Fax. The list of printers appears on the left of the window.
3. Select your printer in the list and then click the Options & Supplies button.
4. In the window, click the Driver tab and select the printer’s driver from the Print Using list.
5. Enable the installed features:

• To specify the amount of RAM memory available, select the amount of memory from the drop-
down Memory Capacity list.

• To enable the optional 250-sheet feeder, click Paper Tray Configuration and select 2-Tray 
from the drop-down list.

• If you have enough memory to use the RAM Disk feature (minimum of 512 MB required), 
select Available from the RAM Disk drop-down list.
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• To enable the duplex unit, select Available from the Duplex Unit drop-down list.
6. Click OK.

Enabling Optional Features for Linux
Note: These instructions are for using Common UNIX Printing System (CUPS), accessed through a 
Web browser.

1. Open your computer’s Web browser. In the address field, type http://127.0.0.1:631 and then press 
Enter.

2. At the CUPS Home tab, click the Manage Printers button.
3. Locate your printer in the list and then click the Set Printer Options button for your printer.
4. At the Set Printer Options page, enable the optional features installed on your printer:

• In the Memory field, select the amount of Memory in MB.
• If you have the 250-sheet feeder installed, select 2-Tray in the Paper Tray Configuration field.
• To enable RAM Disk (minimum 512 MB required), select the Available option.
• To enable automatic 2-sided printing, at the Duplex Unit field, select the Available option.

5. Click Set Printer Options to save the settings.



Installation and Setup

Phaser 6140 Color Laser Printer
User Guide

48



4

Phaser 6140 Color Laser Printer
User Guide

49

Printing

This chapter includes:
• Supported Paper and Media on page 50
• Loading Paper on page 55
• Setting Paper Types and Sizes on page 62
• Selecting Printing Options on page 64
• Printing on Specialty Media on page 75
• Printing Custom Sizes on page 84
• Printing on Both Sides of the Paper on page 87
• Printing Using Secure Print on page 90
• Printing Using Proof Print on page 93
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Supported Paper and Media

This section includes:
• Paper Usage Guidelines on page 50
• Paper That Can Damage Your Printer on page 51
• Paper Storage Guidelines on page 51
• Usable Paper on page 52

Your printer is designed to be used with a variety of paper types. Follow the guidelines in this section to 
ensure the best print quality and to avoid jams.

For best results, use Xerox printing media specified for your Phaser 6140 printer. They are guaranteed 
to produce excellent results with your printer.

To order paper or other specialty media, contact your local reseller or go to: 
www.xerox.com/office/6140supplies.

Caution: Damage caused by using unsupported paper, transparencies and other specialty media is 
not covered by the Xerox warranty, service agreement, or Total Satisfaction Guarantee. The Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage may vary outside 
these areas; please contact your local representative for details.

See also: 
Recommended Media List (North America): www.xerox.com/paper
Recommended Media List (Europe): www.xerox.com/europaper

Paper Usage Guidelines

Each printer tray accommodates certain sizes and types of paper or other specialty media. Follow these 
guidelines when loading paper and media in the trays:
• Fan paper or other specialty media before loading in the tray.
• Do not print on label stock once a label has been removed from a sheet.
• Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with 

release strips.
• All envelopes should be printed single-sided only.
• Some wrinkling and embossing may occur when printing envelopes.
• Do not overload the paper trays. Do not load paper above the fill line on the inside of the paper 

guide.
• Adjust the paper guides to fit the paper size. The paper guides click into place when they are 

adjusted correctly.
• If excessive jams occur, use paper or other media from a new package.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=order&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=rmlna&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=rmleu&Language=english
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See also: 
Loading Paper on page 55
Paper Jams on page 146

Paper That Can Damage Your Printer

Your printer is designed to use a variety of media types for print jobs; however, some media can cause 
poor output quality, increased paper jams, or damage to your printer.

Unacceptable media includes:
• Rough or porous media
• Transparencies
• Paper that has been folded or wrinkled
• Paper with staples
• Envelopes with windows or metal clasps
• Padded envelopes
• Non-laser glossy or coated paper
• Perforated media
• Carbon backed
• Pressure sensitive
• Paper designed for use in inkjet printers

Paper Storage Guidelines

Providing good storage conditions for your paper and other media contributes to optimum print 
quality.
• Store paper in dark, cool, relatively dry locations. Most paper items are susceptible to damage from 

ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and fluorescent bulbs, is 
particularly damaging to paper items. The intensity and length of exposure to visible light on 
paper items should be reduced as much as possible.

• Maintain constant temperatures and relative humidity.
• Avoid moisture, excessive humidity, and heat above 32°C (90°F).
• Avoid attics, kitchens, garages, and basements for storing paper. Inside walls are drier than outside 

walls where moisture can collect.
• Store paper flat. Paper should be stored on pallets, cartons, shelves, or in cabinets.
• Avoid having food or drinks in the area where paper is stored or handled.
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

paper in the original packaging. For most commercial cut-size grades, the ream wrapper contains 
an inner lining that protects the paper from moisture loss or gain.
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Usable Paper

Using unsuitable paper may lead to paper jams, poor print quality, printer breakdown, and damage to 
your printer. To use the features of this printer effectively, use the paper recommended here. The types 
of paper that can be used with this printer are listed in the following tables.

Printing on paper that has settings different from the paper size or paper type selected in the printer 
driver, or loading paper into a paper tray unsuitable for the type of print job, may lead to paper jams. 
To ensure that printing is done correctly, select the correct paper size, paper type, and paper tray.

The printed image may fade due to moisture, such as water, rain or vapor. For details, contact your 
reseller.

Tray 1

Paper Size • Letter (8.5 x 11 in.)
• US Folio (8.5 x 13 in.)
• Legal (8.5 x 14 in.)
• Executive (7.25 x 10.5 in.)
• A4 (210 x 297 mm / 8.2 x 11.5 in.)
• A5 (148 x 210 mm / 5.2 x 8.2 in.)
• B5 JIS (182 x 257 mm)
• #10 Envelope (4.1 x 9.5 in.)
• Monarch Envelope (3.8 x 7.5 in.)
• DL Envelope (110 x 220 mm)
• C5 Envelope (162 x 229 mm)
• Custom size range:

Width: 3–8.5 in. (76.2–215.9 mm)
Height: 5–14 in. (127–355.6 mm)

Paper Type and Weight • Plain (65–120 g/m2 / 17–32 lb. Bond)

• Thin Card Stock (100–163 g/m2 / 37–60 lb. Cover)

• Thick Card Stock (160–220 g/m2 / 60–80 lb. Cover)
• Envelope
• Labels
• Letterhead

• Glossy Paper (100–160 g/m2 / 37–60 lb. Cover)

• Thick Glossy (160–220 g/m2 / 60–80 lb. Cover)
• Prepunched
• Colored Paper
• Special (Heavyweight 1)

Loading Capacity 250 sheets (20 lb.)
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250-Sheet Feeder (Tray 2)

Paper Size • Letter (8.5 x 11 in.)
• US Folio (8.5 x 13 in.)
• Legal (8.5 x 14 in.)
• Executive (7.25 x 10.5 in.)
• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• B5 JIS (182 x 257 mm)
• Custom size range:

Width: 5.8–8.5 in. (147.3–215.9 mm)
Height: 8.3–14 in. (210.8–355.6 mm)

Paper Type and Weight • Plain Paper (60–105 g/m2 / 16–28 lb. Bond)
• Letterhead (plain)
• Prepunched (plain)
• Colored Paper (plain)

Loading Capacity 250 sheets (20 lb.)

Manual Feed Slot

Paper Size • Letter (8.5 x 11 in.)
• Legal (8.5 x 14 in.)
• Executive (7.25 x 10.5 in.)
• US Folio (8.5 x 13 in.)
• #10 Commercial Envelope (4.1 x 9.5 in.)
• Monarch Envelope (3.8 x 7.5 in.)
• DL Envelope (110 x 220 mm)
• C5 Envelope (162 x 229 mm)
• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• B5 JIS (182 x 257 mm)
• Custom size range:

Width: 3–8.5 in. (76.2–215.9 mm)
Height: 5–14 in. (127–355.6 mm)
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Paper Type and Weight • Plain (65–120 g/m2 / 17–32 lb. Bond)
• Letterhead (plain)

• Thin Card Stock (100–163 g/m2 / 28–60 lb. Cover)

• Thick Card Stock (160–220 g/m2 / 60–80 lb. Cover)

• Glossy Paper (100–160 g/m2 / 28–60 lb. Cover)

• Thick Glossy Paper (160–200 g/m2 / 60–80 lb. Cover)
• Prepunched (plain)
• Colored Paper (plain)
• Labels
• Envelope (short-edge feed only for Monarch and DL envelopes)
• Special

Loading Capacity 1 sheet at a time

Duplex Unit (2-Sided Printing)

Paper Size • A4 (210 x 297 mm)
• Letter (8.5 x 11 in.)
• US Folio (8.5 x 13 in.)
• Legal (8.5 x 14 in.)
• Custom size range:

Width: 3–8.5 in. (76.2–215.9 mm)
Height: 5–14 in. (127–355.6 mm)

Paper Type and Weight • Plain (60–105 g/m2 / 16–28 lb. Bond)
• Letterhead (plain)
• Prepunched (plain)
• Colored paper (plain)

Loading Capacity 1 sheet at a time

Manual Feed Slot
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Loading Paper

This section includes:
• Loading Paper in Tray 1 on page 55
• Loading Paper in the Manual Feed Slot on page 57
• Loading Paper in the 250-Sheet Feeder (Tray 2) on page 59

Loading Paper in Tray 1

You can use Tray 1 for a wide variety of media, including:
• Plain paper
• Card stock
• Labels
• Envelopes
• Glossy paper
• Pre-printed paper (paper already printed on one side)
• Custom-size paper

For a more complete list of paper types and sizes usable in Tray 1, see Usable Paper on page 52.

Make sure of the following points when loading paper into Tray 1:
• You can load up to 250 sheets or a stack of paper (65–220 gms / 17–40 lb. Bond, 40–80 lb. Cover) 

less than 15 mm high (0.60 in.).
• Tray 1 accepts print media within the following dimensions:

• Width: 76.2–216 mm (3–8.5 in.)
• Length:127–355.6 mm (5–14 in.)

• For automatic 2-sided printing, you can load media in the range of 60–105 g/m2 (16–28 lb. 
Bond).

• Do not load different types of paper at the same time.
• To print high quality, use high-quality paper intended for laser printers.
• Do not remove or add paper to Tray 1 during printing or if there is still paper in the tray. Doing so 

may cause a paper jam. Remove the paper, align it with the new paper and insert both into the tray 
together.

• Do not put any objects other than paper on Tray 1. Also, do not push or force down Tray 1.
• Always load paper short-edge feed first.

For more paper usage guidelines, see Supported Paper and Media on page 50.
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To load paper in Tray 1:
1. Gently pull the paper tray all the way out and then open the output tray to hold the printed sheets.

2. Slide the paper width guides to the edge of the tray. The width guides should be fully extended as 
shown (see picture below).

3. Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the 
edges of the stack on a level surface.

6140-005 6140-007

6140-006

6140-008
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4. Insert all media faceup and top edge first into the paper tray.

Notes:
• Do not force the paper into the tray.

• Be careful not to bend the paper.

5. Slide the paper width guides until they rest lightly against the edge of the paper stack.

Note: When Size Mismatch (in the PCL driver’s Advanced tab, or in the PostScript driver’s Details 
section in the Advanced tab) is set to Use Printer Settings, you must set the paper type and size 
for the tray you intend to use on the printer control panel in advance.

6. Insert the tray back into the printer until it stops.

Caution: Be careful not to use excessive force on the tray. Doing so could damage the printer.

See also: 
Setting Paper Types and Sizes on page 62

Loading Paper in the Manual Feed Slot

Use the manual feed slot for a wide range of media including:
• Plain paper
• Thin card stock
• Glossy paper (Coated 2 and Coated 3)
• Labels
• Envelopes

For a more complete list of paper types and sizes usable in the Manual Feed Slot, see Usable Paper on 
page 52.

To avoid problems during printing, make sure of the following points:
• Use several sheets of the media only when adjusting the paper width guides.
• Holding the media on both sides, slowly and evenly insert the media into the printer.
• If the media looks skewed after the printer pulls it in, gently remove the media and reseat it. Then 

press the OK button or wait for the automatic calibration to start.

6140-009 6140-010
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To load paper in the manual feed slot:
1. Slide the paper guides of the manual feed slot to fit the media you are using.

2. Open the output tray to hold the printed sheets.
3. Place the print media into the slot with the print side facedown and the top of the sheet entering 

the printer first.

Note: You can insert paper during the printer’s ready mode or sleep mode. The printer 
automatically detects the paper and holds it while it waits for a print job to be sent.

6140-0076140-011

6140-012
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Loading Paper in the 250-Sheet Feeder (Tray 2)

You can use the 250-sheet feeder for the following types of media:
• Plain paper
• Letterhead
• Prepunched
• Colored paper

For supported paper sizes and weights, see Usable Paper on page 52.

To avoid problems during printing, make sure of the following points:
• Do not load different types of paper at the same time.
• To print high quality, use high-quality paper intended for laser printers.
• Do not remove or add paper to the 250-sheet feeder during printing, or if there is still paper in the 

tray. Doing so may cause a paper jam. Remove the paper, align it with the new paper, and insert 
both into the tray together.

• Do not put any objects other than paper on the tray. Also, do not push or force down the tray.
• Always load paper short-edge feed first.

Caution: Do not remove the tray during printing because it may cause a paper jam.

To load paper in the 250-sheet feeder:
1. Gently pull the paper tray out of the printer.

2. Open the output tray to hold the printed sheets.

6140-014
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3. Slide the paper width guides to the edge of the tray. The width guides should be fully extended as 
shown (see picture below).

4. Squeeze the green tab on the length guide and then slide the tray until the arrow lines up with the 
appropriate paper size. The guide clicks into place.

5. Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the 
edges of the stack on a level surface.

6. Place the print media into the tray with the print side faceup.

Note: Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

6140-013

A5 B5 A4 8.5”
7.25”

14”

13”

A4

6140-015

A4

B5

11”

10.5”

6140-008
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7. Slide the width and length guides until they rest lightly against the edge of the print media stack.

Note: Be careful not to bend the paper.

Note: When Size Mismatch (in the PCL driver’s Advanced tab, or in the PostScript driver’s Details 
section in the Advanced tab) is set to Use Printer Settings, you must set the paper type and size 
for the tray you intend to use on the printer control panel in advance.

8. Insert the tray back into the printer until it stops. 

Caution: Be careful not to use excessive force on the tray. Doing so could damage the printer.

See also: 
Setting Paper Types and Sizes on page 62

6140-010
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Setting Paper Types and Sizes

This section includes:
• Setting the Paper Type on page 62
• Setting the Paper Size on page 62

When loading paper in paper Tray 1 or the 250-sheet feeder (Tray 2), you must set the paper type on 
the printer control panel.

Notes:
• If None is selected in the Paper Type menu in the printer driver, printing will default to the 

control panel settings. Printing will be performed only when the settings for the paper size and 
type configured in the printer driver match the settings on the control panel. If the settings in 
the printer driver and control panel do not match, follow the instructions displayed on the control 
panel.

• You can also select to display a message prompting the user to set the paper size and type on 
the control panel every time paper is loaded into a tray. For details, see Tray Settings Menu on 
page 108.

Setting the Paper Type
Caution: Paper type settings must match those of the actual paper loaded in the tray; otherwise, 
print-quality problems can occur.

Note: If None is selected in the Paper Type menu in the printer driver, printing will default to the 
control panel settings. Printing will be performed only when the settings for the paper size and type 
configured in the printer driver match the settings on the control panel. If the settings in the 
printer driver and control panel do not match, follow the instructions displayed on the control 
panel.

To set the paper type for paper in a tray:
1. On the printer control panel, press the Menu button to display the Menu screen.
2. Press the Down Arrow button to go to Tray Settings and then press the OK button.
3. Arrow down to the tray you are setting and then press OK.
4. At Paper Type, press OK.
5. Arrow down to the type of paper that is loaded in the tray and then press OK.
6. When done, press the Menu button to leave the menu.

Setting the Paper Size

To set the paper size for paper in a tray:
1. On the printer control panel, press the Menu button to display the Menu screen.
2. Press the Down Arrow button to go to Tray Settings and then press the OK button.
3. Arrow down to the tray you are setting and then press OK.
4. Arrow down to Paper Size and press the OK button.
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5. Select the paper size and then press OK.
6. When done, press the Menu button to leave the menu.
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Selecting Printing Options

This section includes:
• Selecting Printing Defaults in Windows on page 64
• Selecting Printing Defaults in Windows for a Shared Network Printer on page 65
• Selecting Printing Options for an Individual Job in Windows on page 65
• Selecting Printing Options for an Individual Job in Macintosh on page 70

Note: Printer driver settings override those set at the printer control panel when you print from the 
driver on your computer.

Selecting Printing Defaults in Windows
Notes:
• These instructions are for setting printer driver defaults for the printer drivers installed on your 

computer. If the printer is shared on a network, you can set defaults that will apply to that 
printer for every user who accesses it over the network. For details, see Selecting Printing Defaults 
in Windows for a Shared Network Printer on page 65.

• When you select printing preferences using this method, these will be the default settings used 
for all print jobs sent to the printer from your computer using the specific driver unless you 
override them for an individual print job.

1. Navigate to your computer’s list of printers:
• For Windows XP, click Start > Settings > Printers and Faxes.
• For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
• For Windows 2000 and Windows Server 2003, click Start > Settings > Printers.
• For Windows Server 2008, click Start > Settings > Printers.

2. In the Printers folder, right-click the name of your printer driver (printer name + PCL 6 or PS) and 
select Printing Preferences.

3. Make selections on the driver tabs as desired and then click OK to save your selections.
4. Set defaults for the other printer driver if applicable.

Note: For more information about Windows printer driver options, click the Help button in the 
Printing Preferences dialog box to view the online help.
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Selecting Printing Defaults in Windows for a Shared Network Printer

If the printer is shared on a network, you can set printing defaults that apply to anyone who accesses it 
from the network. These network-level defaults can be overridden by the driver settings on an 
individual user’s computer, however.
1. Navigate to your computer’s list of printers:

• For Windows XP, click Start > Settings > Printers and Faxes.
• For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
• For Windows 2000 and Windows Server 2003, click Start > Settings > Printers.
• For Windows Server 2008, click Start > Settings > Printers.

2. In the Printers folder, right-click the name of your printer driver (printer name + PCL 6 or PS) and 
select Properties.

3. In the printer Properties dialog box, click the Advanced tab.
4. In the Advanced tab, click the Printing Defaults button.
5. Make selections on the driver tabs as desired and then click Apply to apply your selections.
6. Click OK to save your selections.

Selecting Printing Options for an Individual Job in Windows

This section includes:
• Printing Options for Windows PostScript Driver on page 66
• Printing Options for Windows PCL Driver on page 68

If you want to use special printing options for a particular job only, change the printer driver settings in 
the application you are printing from before sending the job to the printer.

Note: The printer driver has its own online help you can use for more information on selecting 
printing options. In the driver dialog boxes, click the Help button.

To select printing options:
1. With the desired document or graphic open in your application, open the Print dialog box.
2. Select your Phaser 6140 printer (either PostScript or PCL) and then click the Properties button to 

open the printer driver dialog box.
3. Make selections from the driver dialog box tabs as desired, beginning with settings in the 

Paper/Output tab. For a list of options, see Printing Options for Windows PostScript Driver on 
page 66, and Printing Options for Windows PCL Driver on page 68.

Note: In the PCL driver for Windows, you can save a set of printing options with a distinctive name 
and apply them to other print jobs. For instructions, refer to the online help: click the Help button in 
the printer driver dialog box.
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Printing Options for Windows PostScript Driver

For detailed information on using the printer driver options, click the Help button in the printer driver 
dialog boxes to access the driver online help.

Note: For optional printer features to be available in the printer driver dialogs, the optional features 
must be installed and enabled. If you have not enabled your installed optional features, see 
Enabling Optional Features on page 44.

Driver Tab Printing Option

Paper/Output • Job Type: Specifies the type of print job: Normal Print, Secure Print, 
Proof Print (Secure and Proof print available with extra RAM memory 
only).

• 2-Sided Print: 1-Sided Print, Flip on long edge, Flip on short edge.
• Paper Size: Specifies the size of the paper to print on, including 

specifying a custom paper size.
• Paper Tray: Specifies which paper tray to print to when the Paper Tray 

setting in the PostScript printer driver is set to Auto Select.
• Paper Type: Specifies the type of paper in the tray.
• Image Orientation: Portrait or Landscape.
• Output Color: Color or Black and White.
• Saved Settings: Enables you to save the current settings under a 

specific name so that they can be used repeatedly. Also enables you to 
load and edit a set of saved settings.

• Printer Status button: Opens the printer’s internal settings page in 
CentreWare IS, in your computer’s Web browser (if the printer is 
connected to a network).

• Defaults button: Returns all of the Paper/Output tab settings to their 
defaults.

• Default All button: Returns all settings in the printer’s Properties dialog 
to their defaults.

• Help button: Opens the printer driver’s online help for the Paper/Output 
tab.

Image Options • Image Quality: Affects the quality of the print by specifying the speed 
at which the page prints.

• Brightness: Makes the printed image or page darker or lighter.
• Color Correction: Specifies how color is applied to printed images, text, 

and photographs.
• Color Balance button: Enables you to specify the density of each color 

used for printing.
• Defaults button: Returns all of the Image Options tab settings to their 

defaults.
• Help button: Opens the printer driver’s online help for the Image 

Options tab.
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Layout • Pages per Sheet (N-up): For multiple-page documents, enables you to 
print more than one page per sheet of paper, including Booklet print.

• Draw Outlines: When multiple pages are printed per sheet, prints a 
border around each page.

• Fit to New Paper Size: Select the output paper size to fit the page to.
• Defaults button: Returns all of the Layout tab settings to their defaults.
• Help button: Opens the printer driver’s online help for the Layout tab.

Advanced • Image Options: Enables you to set print resolution, image color 
management and method used, True Type font configuration, and 
image magnification or reduction percentage for printed images.

• Document Options: Enables you to set PostScript print speed, True Type 
font download method, PostScript error reporting, page orientation for 
the printer’s manual feed slot, various color settings, order of pages 
printed, etc.

• Help button: Opens the printer driver’s online help for the Advanced 
tab.

• Set Features to Default button: Returns all of the Advanced tab 
settings to their defaults.

Driver Tab Printing Option
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Printing Options for Windows PCL Driver

For detailed information on using the printer driver options, click the Help button in the printer driver 
dialog boxes to access the online help.

Note: For optional printer features to be available in the printer driver dialogs, the optional features 
must be installed and enabled. If you have not enabled your installed optional features, see 
Enabling Optional Features on page 44.

Driver Tab Printing Option

Paper/Output • Job Type: Specifies the type of print job: Normal Print, Secure Print, 
Proof Print (Secure and Proof print available with extra RAM memory 
only).

• 2-Sided Print: 1-Sided Print, Flip on long edge, Flip on short edge.
• Paper Size: Specifies the size of the paper to print on, including 

specifying a custom paper size.
• Output Color: Color or Black and White.
• Paper Type: Specifies the type of paper in the tray.
• Saved Settings: Enables you to save the current settings under a 

specific name so that they can be used repeatedly. Also enables you to 
load and edit a set of saved settings.

• Paper Tray: Specifies which paper tray to print to when the Paper Tray 
setting in the PCL driver is set to Auto Select.

• Manual Feed Slot Orientation: Portrait or Landscape.
• Covers / Separators button: Enables you to specify cover and separator 

pages for print jobs.
• Printer Status button: Opens the printer’s internal settings page in 

CentreWare IS, in your computer’s Web browser (if the printer is 
connected to a network).

• Defaults button: Returns all of the Paper/Output tab settings to their 
defaults.
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Image Options • Image Quality: Affects the print quality by specifying the speed at 
which the page prints.

• Output Color: Specifies Color or Black and White.
• Output Recognition: When Color is selected in the Output Color field, 

selecting this check box causes some chromatic colors to be considered 
as black color and to be printed as black.

• Image Adjustment Mode: Recommended, ICM Adjustment (System), 
CMS Adjustment (Application), Complementary Color Conversion.

• Image Types: Enables you to specify a printing mode to match the 
characteristics of the image to be printed.

• Image Auto Correction: Determines the characteristics of a specified 
image type, such as photographs on a page, and automatically 
performs correction for it.

• Image Settings button: Opens the Image Settings tab of the Graphics 
Properties dialog box.

• Color Balance button: Opens the Color Balance tab of the Graphics 
Properties dialog box.

• Profile Settings button: Opens the Profile Settings tab of the Graphics 
Properties dialog box.

• Defaults button: Returns all of the Image Option tab settings to their 
defaults.

Layout • Pages per Sheet (N-up): For multiple-page documents, enables you to 
print more than one page on one sheet of paper.

• Image Order: (Available only if more than one page is being printed on 
a sheet.) Determines the order in which pages are printed on the sheet.

• Draw Outlines: When multiple pages are printer per sheet, prints a 
border around each page.

• Booklet/Poster/Mixed Document/Rotation button: Provides settings 
for printing documents in booklet format, for printing one page of data 
enlarged over multiple pages of paper (poster print), and for specifying 
an orientation for files with pages that have mixed orientations.

• Fit to New Paper Size: Select the output paper size to fit the page to.
• Reduce/Enlarge: Specifies percentage to reduce or enlarge the image 

being printed.
• Image Orientation: Specifies Portrait or Landscape.
• Margin Shift/Margins button: Provides access to page margin settings.
• Defaults button: Returns all of the Layout tab settings to their defaults.

Watermarks/Overlays Provides access to settings for creating watermarks and overlays to print on 
pages. A page overlay is a group of PCL commands and/or data created 
from a page image and is stored as an external file.

Advanced Provides access to advanced printer options such as skipping blank pages, 
printing in draft mode, banner mode, size mismatch settings, certain 
graphic settings, and font settings.

Driver Tab Printing Option
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Selecting Printing Options for an Individual Job in Macintosh

If you want to use special printing options for a particular job only, change the printer driver settings in 
the application you are printing from before sending the job to the printer.

Note: The printer driver has its own online help you can use for more information on selecting 
printing options.

1. With the document open in your application, click File and then click Print.
2. Select the desired printing options from the menus and drop-down lists that are displayed. For a list 

of options, see Printing Options for Macintosh OS X on page 70.

Note: In Macintosh OS X, click Save from the Presets drop-down list on the Print menu screen to 
save the current printer settings. You can create multiple presets and save each with its own 
distinctive name and printer settings. To print jobs using specific printer settings, select the 
applicable saved preset in the Presets list.

3. Click Print to print the job.

Printing Options for Macintosh OS X

For detailed information on using the printer driver options, click the question mark button in the 
printer driver dialog boxes to access the online help.
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Mac OS X Versions 10.4 and 10.5

Driver Drop-Down Title Printing Options

Copies & Pages • Copies: Specifies number of copies and whether to collate.
• Pages: All, Current, Selection, From x to x, Page range.

Layout • Pages per Sheet: Specifies the number of pages to print on each sheet 
of paper.

• Layout Direction: Specifies the order in which to print the pages when 
printing multiple pages on one sheet of paper.

• Border: Specifies the type and width of boarder to print around each 
page printed on the sheet of paper.

• Two-Sided: When selected, specifies whether to flip the page on the 
long edge or the short edge (duplex unit required).

Color Matching (version 10.5 
only)

• ColorSync: This selection allows you to choose a profile from the Profile 
selection menu.

• In printer

Paper Handling • Pages To Print: All Pages, Odd Only, Even Only
• Destination paper size: (Active only when Scale to fit paper size is 

selected.) Specifies the paper size to print to.
• Page Order: Automatic, Normal, Reverse

Paper Feed • All pages from: Specifies the tray to print all pages from: Auto Select, 
Manual Feed Slot, Tray 1, Tray 2 (only if installed).

• First page from: Specifies the tray from which to print the first page.
• Remaining from: Specifies the tray from which to print the remaining 

pages.

Cover Page • Print Cover Page: None, Before document, After document.
When an option other than None is selected, a cover page prints.

• Cover Page Type: Classified, Confidential, Secret, Standard, Topsecret, 
Unclassified

• Billing Info: A field in which you can specify billing information to print 
on the cover page.

Scheduler • Print Document: Now, At [time], On Hold
• Priority: Urgent, High, Medium, Low

Job Type Specifies the type of print job: Normal Print, Secure Print, Proof Print 
(Secure and Proof print available with extra RAM memory only).

Job Control • Account Mode: User, Administrator
• User Settings: Specifies account settings such as name and password.
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Printer Features • Print Quality/Color: Specifies output color, image quality, brightness, 
color correction method, halftone screen settings, and adjust color 
balance.

• Color Adjustment: Specifies RGB color adjustment settings.
• Color Balance (C, M, Y, K): Specifies amount of color to use.
• Media Handling: Specifies manual feed slot orientation, paper type, 

size mismatch setting, and custom paper auto orientation.
• Printer-specific Options: Image Enhancement, Draft Mode, Skip Blank 

Pages, Halftone Screen Lock, Faster B/W documents.

Supply Levels Displays bar graph showing level of toner left in each toner cartridge, and 
the useful life remaining of the Imaging Unit.

Summary Summarizes the driver selections.

Driver Drop-Down Title Printing Options
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Mac OS X Version 10.3

Driver Drop-Down Title Printing Options

Copies & Pages • Copies: Specifies number of copies and whether to collate.
• Pages: All, From x to x.

Layout • Pages per Sheet: Specifies the number of pages to print on each sheet 
of paper.

• Layout Direction: Specifies the order in which to print the pages when 
printing multiple pages on one sheet of paper.

• Border: Specifies the type and width of boarder to print around each 
page printed on the sheet of paper.

• Two-Sided: When selected, specifies whether to flip the page on the 
long edge or the short edge (duplex unit required).

Output Options Save File As:
• PDF
• PostScript

Scheduler • Print document: Now, At [time], On Hold
• Priority: Urgent, High, Medium, Low

Paper Handling • Reverse page order
• Print: All, Odd, Even

ColorSync • Color matching
• Quartz filter

Cover Page • Print cover page: When selected prints a cover page before or after the 
document.

• Cover Page Type: Standard, Classified, Confidential, Secret, Topsecret, 
Unclassified

• Billing Info: A field in which you can specify billing information to print 
on the cover page.

Error Handling • PostScript errors
• Tray Switching

Paper Feed • All pages from: Specifies the tray to print all pages from: Auto Select, 
Manual Feed Slot, Tray 1, Tray 2 (only if installed).

• First page from: Specifies the tray from which to print the first page.
• Remaining from: Specifies the tray from which to print the remaining 

pages.

Job Control • Account Mode: User, Administrator
• User Settings: Specifies account settings such as name and password.

Job Type Specifies the type of print job: Normal Print, Secure Print, Proof Print 
(Secure and Proof print available with extra RAM memory only).
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Printer Features • Print Quality/Color: Specifies output color, image quality, brightness, 
color correction method, halftone screen settings, and adjust color 
balance.

• Color Adjustment: Specifies RGB color adjustment settings.
• Color Balance (C, M, Y, K): Specifies amount of color to use.
• Media Handling: Specifies manual feed slot orientation, paper type, 

size mismatch setting, and custom paper auto orientation.
• Printer-specific Options: Image Enhancement, Draft Mode, Skip Blank 

Pages, Halftone Screen Lock, Faster B/W documents.

Summary Summarizes the driver selections.

Driver Drop-Down Title Printing Options
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Printing on Specialty Media

This section includes:
• Printing Envelopes on page 75
• Printing Labels on page 78
• Printing on Glossy Paper on page 80
• Printing on Card Stock on page 82

Printing Envelopes

This section includes:
• Envelope Printing Guidelines on page 75
• Printing Envelopes from Tray 1 on page 76
• Printing Envelopes from the Manual Feed Slot on page 77
• Printing Envelopes using the PostScript Driver on page 77
• Printing Envelopes using the PCL Driver on page 78

Envelope Printing Guidelines
• Envelopes can be printed from Tray 1 and from the manual feed slot.
• You cannot perform automatic 2-sided printing using envelopes.
• Successful envelope printing is highly dependent on the quality and construction of the envelopes. 

Use envelopes made specifically for laser printers, in the supported sizes. For a listing of supported 
envelope sizes for Tray 1 and the manual feed slot, see Usable Paper on page 52.

• Store unused envelopes in their packaging to avoid the effects of moisture and dryness which can 
affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before 
or during printing. For best results, maintain constant temperatures and relative humidity.

• Do not use padded envelopes; purchase envelopes that lie flat.
• Remove air bubbles from the envelopes before loading by setting a heavy book on top of the 

envelopes.
• If wrinkling or embossing problems occur, use a different brand of envelope made specifically for 

laser printers.

Caution: Never use envelopes with windows or metal clasps because they can damage the printer. 
Damage caused by using unsupported envelopes is not covered under the Xerox warranty, service 
agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available in the 
United States and Canada. Coverage may vary outside these areas; please contact your local 
representative for details.
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Printing Envelopes from Tray 1

To load envelopes:
1. Gently pull out the paper tray and then open the output tray to hold the printed envelopes. For 

details, see Loading Paper in Tray 1 on page 55.
2. Slide the paper guides to the edge of the tray.
3. Insert the envelopes with the flaps closed and the side to be printed faceup. You can load 

envelopes up to the maximum fill line in the tray.

Note: You cannot print on the reverse side of the envelope. Envelopes can get wrinkled or the print 
quality can be reduced, depending on the envelope type used.

4. Slide the media guides so they rest lightly against the edges of the envelopes.
5. Insert the tray back into the printer until it stops.
6. On the printer control panel, press the Menu button to display the Menu screen.
7. Press the Down Arrow button to go to Tray Settings and then press the OK button.
8. At Tray 1, press OK.
9. At Paper Type, press OK.
10. At Envelope, press OK.
11. Press the Back Arrow button once to back out of the menu and then press the Down Arrow button 

to select Paper Size and then press OK.
12. Arrow down the desired envelope size and then press OK.
13. Do one of the following:

• If you are printing using the PostScript driver, go to Printing Envelopes using the PostScript 
Driver on page 77.

• If you are printing using the PCL driver, go to Printing Envelopes using the PCL Driver on 
page 78.

6140-016
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Printing Envelopes from the Manual Feed Slot
Note: You can load only one envelope at a time in the manual feed slot.

To load an envelope:
1. Slide the paper guides of the manual feed slot to fit the media you are using and then open the 

output tray to hold the printed envelopes. For details, see Loading Paper in the Manual Feed Slot on 
page 57.

2. Insert one envelope with the side to be printed facedown and the flap on the right as shown in the 
illustration.

3. Slide the paper guides so they rest lightly against the edge of the envelope.
4. Do one of the following:

• If you are printing using the PostScript driver, go to Printing Envelopes using the PostScript 
Driver on page 77.

• If you are printing using the PCL driver, go to Printing Envelopes using the PCL Driver on 
page 78.

Printing Envelopes using the PostScript Driver
1. After loading the envelopes in the appropriate tray or the manual feed slot, in the application you 

are printing from, open the Print dialog.
2. Select the Phaser 6140 PostScript printer from the list of printers and then click the Properties (or 

Preferences) button.
3. In the Paper/Output tab, do the following:

a. From the Paper Type list, select Envelope.
b. From the Paper Size list, select the envelope size.
c. From the Paper Tray list, select the tray you are using.

4. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.

6140-017
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Printing Envelopes using the PCL Driver
1. After loading the envelopes in the appropriate tray, in the application you are printing from, open 

the Print dialog.
2. Select the Phaser 6140 PCL printer from the list of printers and then click the Properties (or 

Preferences) button.
3. In the Paper/Output tab, do the following:

a. From the Paper Type list, select Envelope.
b. From the Paper Size list, select the envelope size.
c. From the Paper Tray list, select the tray you are using.

4. Select the Layout tab and then, from the Fit to New Paper Size list, select the envelope size.

Note: Some applications do not allow you to rotate the information to be printed on the envelope 
so that it will match the way the envelopes are fed into the printer. Since you cannot change the 
way the envelope is fed into the printer, you can use the printer driver’s special rotation setting. In 
the Layout tab, click the Booklet/Poster/Mixed Document/Rotation button and select Portrait & 
Landscape [For envelopes] from the Image Rotation (180deg) list and then click OK.

5. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.

Printing Labels

This section includes:
• Label Printing Guidelines on page 78
• Printing Labels from Tray 1 on page 79
• Printing Labels from the Manual Feed Slot on page 79

To order paper or other specialty media, contact your local reseller or go to the Xerox Supplies website 
at www.xerox.com/office/6140supplies.

Label Printing Guidelines
Note: Labels can be printed from Tray 1 and from the manual feed slot.

• Do not use vinyl labels.
• Print only on one side of the sheet of labels. Use full sheet labels only.

Caution: Do not use any sheet where labels are missing; it may damage the printer.

• Do not use labels that are perforated, have backing sheets that have partially peeled away or that 
have parts of the labels already removed.

• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 
packaging until ready to use. Return any unused sheets of labels to the original packaging and 
reseal it.

• Do not store label sheets in extremely dry or humid conditions or extremely hot or cold conditions. 
Storing them in extreme conditions may cause print quality problems or cause them to jam in the 
printer.

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=tech&Language=english
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Printing Labels from Tray 1
1. Gently pull out the paper tray and slide open the paper guides, then open the output tray to hold 

the printed labels. For details, see Loading Paper in Tray 1 on page 55.
2. Fan the labels to release sheets that are stuck together.
3. Insert the labels with the side to be printed faceup and with the top of the sheets entering first 

into the tray. Do not load more than 25 sheets.
4. Adjust the paper guides to fit the sheets.

5. In the application you are using to print the labels, open the Print dialog box and then click the 
Properties (or Preferences) button.

6. In the Paper/Output tab of the printer driver, do the following:
a. From the Paper Tray list, select Tray 1.
b. From the Paper Size list, select the label sheet size.
c. From the Paper Type list, select Labels.

7. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.

Printing Labels from the Manual Feed Slot
1. Slide the paper guides of the manual feed slot to fit the label sheet and then open the printer’s 

output tray. For details, see Loading Paper in the Manual Feed Slot on page 57.
2. With the top of the sheet toward the printer, slowly insert one label sheet facedown into the 

manual feel slot until it stops. Ensure that the sheet is entered straight, not crooked. If necessary, 
reposition the paper guides to fit the sheet.

3. In the application you are using to create the labels, open the Print dialog box and select the 
Phaser 6140 printer (if you have both the PCL and the PostScript drivers installed, you can use 
either one).

6140-018
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4. Click the Properties button.
5. In the Paper/Output tab, do the following:

a. From the Paper Size list, select the size of the sheet of labels.
b. From the Paper Type list, select Labels.
c. From the Paper Tray list, select Manual Feed Slot.

6. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.

Printing on Glossy Paper

This section includes:
• Glossy Paper Printing Guidelines on page 80
• Printing on Glossy Paper from Tray 1 on page 80
• Printing on Glossy Paper from the Manual Feed Slot on page 81

Glossy Paper Printing Guidelines
• You can print on glossy paper from Tray 1 and from the manual feed slot.
• You cannot perform automatic 2-sided printing using glossy paper.
• Do not open sealed packages of glossy paper until you are ready to load them into the printer.
• Leave glossy paper in the original wrapper and store unopened packages in the original shipping 

carton until ready to use.
• Remove all other paper from the tray before loading glossy paper.
• Load only the amount of glossy paper you plan to use, and remove the unused portion from the 

tray when you are finished printing. Put the unused glossy paper back in the original wrapper and 
seal it for later use.

• Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy paper to 
curl and jam the printer.

Printing on Glossy Paper from Tray 1
1. Gently pull out the paper tray and slide open the paper guides, then open the output tray to hold 

the printed sheets. For details, see Loading Paper in Tray 1 on page 55.
2. Fan the sheets to release any that are stuck together.
3. Insert the glossy paper into the tray with the side to be printed faceup.

Note: Do not load more than 25 sheets. Do not load the paper above the fill line indicated on the 
tray. Overloading the tray may cause jams.

6140-020
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4. In the application you are using to print from, open the Print dialog box and select the 
Phaser 6140 printer (if you have both the PCL and the PostScript drivers installed, you can use 
either one).

5. Click the Properties button.
6. In the Paper/Output tab, do the following:

a. From the Paper Size list, select the paper size.
b. From the Paper Type list, select Glossy Paper.
c. From the Paper Tray list, select Tray 1.

7. Select any other desired settings, such as page orientation, and then click OK.
8. In the Print dialog box, click OK (or Print) to start printing.

Printing on Glossy Paper from the Manual Feed Slot
1. Slide the paper guides of the manual feed slot to fit the sheet and then open the printer’s output 

tray. For details, see Loading Paper in the Manual Feed Slot on page 57.
2. With the top of the sheet toward the printer, slowly insert one sheet into the manual feel slot until 

it stops. Ensure that the sheet is entered straight, not crooked. If necessary, reposition the paper 
guides to fit the sheet.

3. In the application you are using to print from, open the Print dialog box and select the 
Phaser 6140 printer (if you have both the PCL and the PostScript drivers installed, you can use 
either one).

4. Click the Properties button.
5. In the Paper/Output tab, do the following:

a. From the Paper Size list, select the size of the glossy paper.
b. From the Paper Type list, select Glossy Paper (or Thick Glossy Paper if you are using thick 

glossy).
c. From the Paper Tray list, select Manual Feed Slot.

6. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.

6140-021
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Printing on Card Stock

This section includes:
• Card Stock Printing Guidelines on page 82
• Printing on Card Stock from Tray 1 on page 82
• Printing on Card Stock from the Manual Feed Slot on page 83

Card Stock Printing Guidelines
• You can print on thin card stock and thick card stock from Tray 1 and from the manual feed slot.
• You cannot perform automatic 2-sided printing using card stock.

• Thin card stock acceptable for this printer is 100–163 g/m2 / 37–60 lb. cover.

• Thick card stock acceptable for this printer is 160–220 g/m2 / 60–80 lb. cover. Test all thick stock to 
ensure acceptable performance.

• Do not load card stock of mixed thicknesses in the tray at the same time; use only one thicknesses 
in the tray per print job.

• Do not use card stocks that are coated or designed for inkjet printers.

Printing on Card Stock from Tray 1
1. Gently pull out the paper tray and slide open the paper guides, then open the output tray to hold 

the printed sheets. For details, see Loading Paper in Tray 1 on page 55.
2. Fan the sheets to release any that are stuck together.
3. Insert the card stock into the tray with the side to be printed faceup.

Note: Do not load a stack of card stock higher than 27.6 mm (1.08 in.) in the tray.

4. In the application you are printing from, open the Print dialog box and select the Phaser 6140 
printer (if you have both the PCL and the PostScript drivers installed, you can use either one).

5. Click the Properties button.
6. In the Paper/Output tab, do the following:

a. From the Paper Size list, select the size of the card stock.
b. From the Paper Type list, select either Thin Card Stock or Thick Card Stock as appropriate.
c. From the Paper Tray list, select Tray 1.

7. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.
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Printing on Card Stock from the Manual Feed Slot
1. Slide the paper guides of the manual feed slot to fit the sheet and then open the printer’s output 

tray. For details, see Loading Paper in the Manual Feed Slot on page 57.
2. With the top of the sheet toward the printer, slowly insert one sheet into the manual feel slot until 

it stops. Ensure that the sheet is entered straight, not crooked. If necessary, reposition the paper 
guides to fit the sheet.

3. In the application you are using to print, open the Print dialog box and select the Phaser 6140 
printer (if you have both the PCL and the PostScript drivers installed, you can use either one).

4. Click the Properties button.
5. In the Paper/Output tab, do the following:

a. From the Paper Size list, select the size of the card stock.
b. From the Paper Type list, select Thin Card Stock or Thick Card Stock as appropriate.
c. From the Paper Tray list, select Manual Feed Slot.

6. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.

6140-021
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Printing Custom Sizes

This section includes:
• Defining Custom Paper Sizes on page 84
• Printing on Custom-size Paper on page 86

Note: Custom-size paper can be loaded into all trays.

Defining Custom Paper Sizes

This section includes:
• Defining the Custom Page Size in the PostScript Driver on page 84
• Creating a Custom Paper Size for the PostScript Driver on page 85
• Creating a Custom Paper Size for the PCL Driver on page 85

Notes:
• The custom size defined must be within the maximum and minimum size ranges for the printer 

paper tray you are using. For details, see the custom size paper ranges given for each tray in 
Usable Paper on page 52.

• You can create custom paper sizes for use with both the PostScript and PCL printer drivers, but 
the method for each is different. For optimum success, follow the instructions carefully.

• If you get an error message when attempting to create a custom size, you may not have 
permission to save custom paper sizes on your computer system. See your system administrator 
for help.

Defining the Custom Page Size in the PostScript Driver
Note: This method does not allow you to save the custom size under a unique name in the printer 
driver. You can save only one custom page size at a time under the Paper Size Custom Page Size. 
Once saved, the dimensions will be retained until you change them. If you want to create a custom 
paper size for the PostScript driver and save it under a unique name for repeat use, see Creating a 
Custom Paper Size for the PostScript Driver on page 85.

1. Open the PostScript printer driver’s settings:
• In Windows, navigate to your printer directory or list and then right-click the Phaser 6140 

PostScript driver and select Properties. In the Properties dialog box, click the Printing 
Preferences button.

• In Macintosh, from the application’s Print menu, select the Phaser 6140 printer and then click 
the Properties button.

2. In the Paper/Output tab of the printer driver, from the Paper Size list, select Custom Page Size.
3. In the PostScript Custom Size Settings dialog box, select the units of measurement to use for 

creating the page size, and then, in the Custom Size Settings section, specify the size for the short 
edge (width) and the long edge (length) of the paper. Click OK.

4. In the Printing Preferences dialog box, click OK.
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To change the saved custom size later, in the Paper/Output tab, click the Edit button below the 
Paper Size field and make the desired changes in the dialog box. Save your changes in all 
applicable dialog boxes.

Creating a Custom Paper Size for the PostScript Driver
Note: This method allows you to create and save a custom paper size under a unique name for use 
with the PostScript driver. You can create as many custom sizes as your printer trays can handle.

1. In Windows, navigate to your printer directory or list. In the Printers and Faxes folder, click the File 
menu and select Server Properties. The Print Server Properties dialog box appears.

2. In the Forms tab, select the Create a new form check box.
3. In the Form name field, type a name for your custom size (overwrite the name that appears in the 

field).
4. In the Form description section, select the units of measurement to use for creating the paper size 

and then define the width and height and printer margins in the corresponding fields.
5. Click the Save Form button and then click Close.

The custom size will be available as an option in the Print dialog box of most applications when you 
select the Phaser 6140 PostScript driver in the application’s Print dialog box (exact location varies 
with the application).

Creating a Custom Paper Size for the PCL Driver
Notes:
• The PCL printer driver is available for Windows only.

• When you create a custom paper size in the PCL driver, it becomes available in the Paper Size list 
of the printer driver’s Paper/Output tab and in most applications’ Print dialog box (exact 
location varies with the application).

1. Navigate to your printer directory or list and then right-click the Phaser 6140 PCL driver and select 
Properties.

2. In the Properties dialog box, click the Configuration tab.
3. At the bottom of the Configuration tab, click the Custom Paper Size button. The Custom Paper 

Size dialog box opens.
4. In the Units section, select the units of measurement to use for defining the page size.
5. In the Short Edge field, specify the width of the page. In the Long Edge field, specify the length of 

the page.
6. To save this custom size under a unique name, verify that the Name Paper Size check box is 

selected and then, in the Paper Name field, type a name for this custom size.
7. Click OK.
8. In the driver’s Properties dialog box, click OK.

The custom size will be available as an option in the Print dialog box of most applications when you 
select the Phaser 6140 PCL driver in the application’s Print dialog box. The custom size will also be 
available in the PCL driver’s Paper Size field in the Paper/Output tab.
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Printing on Custom-size Paper

This section includes the following:
• Printing on Custom-size Paper Using the PostScript Driver on page 86
• Printing on Custom-size Paper Using the PCL Driver on page 86

Note: When setting the paper size in the printer driver and control panel, be sure to specify the 
same size as the actual paper used. Setting the wrong size for printing can cause a printer error. 
This is especially true if you configure a bigger size when using a narrow-width paper.

Printing on Custom-size Paper Using the PostScript Driver
1. Load the custom-size paper in the tray you want to use. For details, see Loading Paper on page 55.
2. In the application you are printing from, open the Print dialog box and select the Phaser 6140 

PostScript driver.
3. Do one of the following:

• To print using a custom size you saved under a unique name, in the Print dialog box, select the 
custom paper size name from the dialog box size menu or list. Click the Properties button and 
skip to step 4.

• To print using the driver’s Custom Page Size defined in the PostScript driver’s properties, in the 
Print dialog box, click the Properties button and then, in the Paper/Output tab, select Custom 
Page Size from the Paper Size list. In the PostScript Custom Size Settings dialog box, leave the 
settings as is or change them if needed to match the paper you are printing on and then click 
OK.

4. In the Paper/Output tab, do the following:
a. From the Paper Type list, select the paper type.
b. From the Paper Tray list, select the tray to print from.

5. Select any other desired options and then click OK.
6. In the Print dialog box, click OK (or Print) to start printing.

Printing on Custom-size Paper Using the PCL Driver
1. Load the custom-size paper in the tray you want to use. For details, see Loading Paper on page 55.
2. In the application you are printing from, open the Print dialog box and select the Phaser 6140 PCL 

driver.
3. Click the Properties button.
4. In the Paper/Output tab, do the following:

a. From the Paper Size list, select the name of a custom-size you created.
b. From the Paper Type list, select the paper type.
c. From the Paper Tray list, select the tray to print to.

5. Select any other desired options and then click OK.
6. In the Print dialog box, click OK (or Print) to start printing.
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Printing on Both Sides of the Paper

This section includes:
• Automatic 2-Sided Printing Guidelines on page 87
• Binding Edge Options on page 87
• Automatic 2-Sided Printing on page 88
• Manual 2-Sided Printing on page 88

Note: Automatic 2-sided printing is available for the Phaser 6140/DN printer configuration. 
Manual 2-sided printing using Tray 1 is available for both Phaser 6140 configurations, but only 
using the PCL 6 printer driver (Windows only). For details, see Performing Manual 2-sided Printing 
from Tray 1 on page 88. However, you can use the manual feed slot to print double-sided pages 
one sheet at a time using the PostScript driver. For details, see Performing Manual 2-sided Printing 
from the Manual Feed Slot on page 89.

Automatic 2-Sided Printing Guidelines

Before printing a 2-sided document, verify that the paper is a supported size for the tray. For a list of 
supported sizes, see Supported Paper and Media on page 50.

Do not use the following media for automatic 2-sided printing:
• Transparencies
• Envelopes
• Labels
• Any die-cut specialty media, such as business cards
• Card stock

Binding Edge Options

When you use the printer driver to select 2-sided printing, you also select the binding edge. The binding 
edge determines how the pages turn. The actual outcome depends on the orientation (portrait or 
landscape) of images on the page, as shown in the following illustrations.

Portrait Landscape

Flip on Long Edge Flip on Short Edge Flip on Long Edge Flip on Short Edge
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Automatic 2-Sided Printing

You can perform automatic 2-sided printing from Tray 1 and, if installed, the 250-sheet feeder (Tray 2).

To perform automatic 2-sided printing:
1. Insert the paper into the desired tray. For more information, see Loading Paper on page 55.
2. In the printer driver, select 2-sided printing:

• Windows users: In the Paper/Output tab, from the 2-Sided Print drop-down list, select either 
Flip on long edge or Flip on short edge.

• Macintosh users: In the Print dialog box, from the Presets menu, select Layout. Then select 
either Long-edged printing or Short-edged printing.

For details, see Binding Edge Options on page 87.
3. Select any other desired printing options and then click OK and then click OK again (or Print) to 

start printing.

Note: For optional printer features to be available in the printer driver dialogs, the optional features 
must be installed and enabled. If you have not enabled your installed optional features, see 
Enabling Optional Features on page 44.

See also: 
Automatic 2-Sided Printing Guidelines on page 87

Manual 2-Sided Printing

This section includes:
• Performing Manual 2-sided Printing from Tray 1 on page 88
• Performing Manual 2-sided Printing from the Manual Feed Slot on page 89

If you do not have the optional duplex unit installed, or if you want to print on media incompatible 
with the duplex unit, you can still print on both sides of certain kinds of media using the instructions in 
this section.

Caution: Use only paper specified for use with this printer. Damage caused by unsupported paper 
is not covered under the Xerox warranty, service agreement, or Total Satisfaction Guarantee. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage may vary 
outside these areas, so contact your local sales representative for details.

Performing Manual 2-sided Printing from Tray 1
Notes:
• This method of manual 2-sided printing is only available using the PCL printer driver.

• You cannot perform manual 2-sided printing on thick card stock or glossy paper using this 
method.

1. Load Tray 1 with the desired paper acceptable for use in Tray 1. For details, see Usable Paper on 
page 52.
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2. In the application you are printing from, open the Print dialog box and select the Phaser 6140 PCL 
driver.

3. Click the Properties button.
4. Click the Advanced tab.
5. In the Other Settings section, in the Items list, select Electronic Sort. In the Electronic Sort field 

below the Items list, select Off.
6. Click the Paper/Output tab and do the following:

a. From the Paper Tray list, select Tray 1.
b. From the 2-Sided Print list, select either Flip on long edge (Manual) or Flip on short edge 

(Manual).
c. From the Paper Type field, select the paper type.
d. Select any other desired settings and then click OK.

7. In the Print dialog box, select the pages to print and then click OK (or Print) to start printing.

Note: You do not need to select to print odd or even pages only. Either select to print all pages or a 
page range. The driver will print the even pages first and then the printer will wait for you to re-
insert the printed pages back into Tray 1.

8. The Setting Method for Paper Tray 1 Duplex window appears on your computer screen. Keep this 
window open until you are finished with the entire print job, since you cannot get it back once you 
close it. This window explains how to reload the printed pages into the paper tray. However, in case 
you did close the window, do the following: without turning the pages over or around, lift them as 
they are and place them into the paper tray. If you have done this correctly, the blank side of the 
pages will be facing up. Close the tray.

9. On the printer control panel, click the OK button to resume printing.

Performing Manual 2-sided Printing from the Manual Feed Slot
1. After printing on one side of a sheet of paper, adjust the paper guides in the manual feed slot to fit 

the paper.
2. Slowly and evenly insert the paper (one sheet only) into the manual feed slot with the side to be 

printed on facedown. The printer will “grab” and hold the paper.
3. If the paper looks skewed after the printer pulls it in, gently remove the paper and re-insert it.
4. Open the file to be printed if it is not already open and then select Print from the File menu.
5. In the Print dialog box, select the desired printer driver and then click the Properties button.
6. In the Paper/Output tab, select the following:

a. From the Paper Size list, select the paper size.
b. From the Paper Type list, select the paper type.
c. From the Paper Tray list, select Manual Feed Slot.

7. Click OK.
8. In the Print dialog box, select the page you want to print on the sheet and then click Print (or OK) 

to start printing.
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Printing Using Secure Print

This section includes:
• Setting Up a Secure Print Job on page 90
• Printing a Secure Print Job on page 91
• Storing a Print Job in Memory on page 92
• Printing a Stored Job on page 92

Notes:
• This special job type requires that you have a minimum of 256 MB of additional memory 

installed in the printer for a minimum total of 512 MB of RAM. For information on your printer 
configuration and available optional features, see Configurations and Options on page 22.

• The printer’s RAM Disk feature must also be enabled for you to use Secure Print. For information 
on enabling this option, see Enabling Optional Features on page 44.

The Secure Print feature enables you to temporarily store a print job in the printer and then print it 
from the printer control panel using a pre-assigned password. You can use this feature to send 
confidential documents to the printer but not have them print until you retrieve them when you are at 
the printer.

You can also store data in the printer without assigning a password. By storing frequently-used data in 
the printer, you can print the data with just an operation from the printer, and without sending the 
data from the computer repeatedly.

Setting Up a Secure Print Job

You set up Secure Print print jobs in the printer driver at your computer. Both the PCL and PostScript 
drivers can be used for Secure Print. After setup, you print the job from the printer’s control panel.
1. From the application you are using to print, open the Print dialog box (for example, from the File 

menu, select Print).
2. Select your Phaser 6140 printer (PostScript or PCL printer driver) and then click the Properties 

button.
3. In the Paper/Output tab of the printer driver Properties dialog box, do the following:

a. From the Job Type list, select Secure Print.
b. If you are using the PostScript driver, click the Setup button. If you are using the PCL driver, 

click the Setting button.
c. In the Secure Print dialog box, type your name (8-character limit) in the Username field and 

then enter a numeric password (numbers only) in the Password field.
d. At the Retrieve Document Name field, do one of the following:

• If you want to use a specific document name to access the document from the printer 
control panel at the time of printing, select Enter Document Name. In the Document 
Name field, type the name of the document as you want it to appear on the printer control 
panel (12-character limit).
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• If you want a timestamp to be displayed on the control panel instead of a document 
name, select Use Existing Name if you are using the PostScript driver. If you are using the 
PCL driver, select Auto Retrieve.

e. Click OK.
4. Select any other desired printing options including paper tray, paper type and paper size, and then 

click OK.
5. In the Print dialog box, click OK (or Print).
6. When you are ready to print, follow the instructions in Printing a Secure Print Job on page 91.

Note: Any print jobs stored in the RAM are erased when the printer is switched off or loses power.

Printing a Secure Print Job
1. After sending the document to be printed as a Secure Print job type, at the printer control panel, 

press the Back Arrow button to access the Walk-Up printing feature.
2. At Secure Print, press the OK button.
3. At your user name (the name you supplied to use for retrieving the document when you set up this 

Secure Print job), press OK.
4. To enter the password, use the arrow buttons to select the password numbers one at a time: press 

the Up Arrow button to increase the number, press the Down Arrow button to decrease the 
number. After entering each number, press the Forward Arrow button. The number you just 
entered displays as an asterisk to keep it private. Enter the next number in the password using the 
same process as before. After entering all of the numbers in the password, press OK.

5. Do one of the following:
• If you selected to retrieve the document using a specific name, then arrow down to the name 

and press OK.
• If you selected to retrieve the document using a timestamp, you will see Select Document and 

a time stamp displayed on the control panel menu. Press OK.
6. Select from the following:

• To delete the document from memory after printing, at Delete after Print press OK.
• To print the document and keep it in the printer’s memory after printing, arrow down to Print 

and Save and then press OK.

Note: Any print jobs stored in the RAM are erased when the printer is switched off or loses power. 
To delete the document without printing it, arrow down to Delete and then press OK.

7. Set the number of copies to print using Up Arrow or Down Arrow buttons and then press OK to 
start printing.

See also: 
Setting Up a Secure Print Job on page 90
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Storing a Print Job in Memory

If you have enough RAM installed in your printer (minimum of 512 MB) and you have the RAM Disk 
feature enabled, you can store a frequently-used print job in the printer’s RAM for printing at any time. 
The print job will stay in the printer’s memory until it is deleted or the printer is switched off.

To create a stored print job:
1. From the application you are using to print, open the Print dialog box.
2. Select your Phaser 6140 printer driver, either PCL or PostScript, and then click the Properties 

button.
3. In the Paper/Output tab of the printer driver Properties dialog box, do the following:

a. From the Job Type list, select Secure Print. The Setup (or Setting) button becomes enabled.
b. Click the Setup (or Setting) button.
c. In the Username field of the Secure Print dialog box, type the username you want to associate 

with this print job (8-character limit).
d. You can enter a numeric password in the Password field or, to make this job available to 

anyone, leave the password field empty.
e. At the Retrieve Document Name field, select Enter Document Name. In the Document Name 

field, type the name of the document as you want it to appear on the printer control panel (12-
character limit).

f. Click OK.
4. Select any other desired printing options including paper tray, paper type and paper size, and then 

click OK.
5. In the Print dialog box, click OK (or Print).

See also: 
Enabling Optional Features on page 44

Printing a Stored Job
1. At the printer control panel, press the Back Arrow button to access the Walk-Up printing menu.
2. At Secure Print, press the OK button.
3. Arrow to the username associated with the stored document you want to print and then press OK.
4. If a password was set for this stored job and you know what it is, follow step 4 in Printing a Secure 

Print Job on page 91.
5. Arrow down to the document name (the one entered in the Document Name field of the Secure 

Print dialog box) and then press OK.
6. Arrow down to Print and Save and press OK.

Note: The stored print job can be deleted after printing if you select Delete after Print instead of 
Print and Save. The print job will also be deleted if the printer is switched off.

7. Set the number of copies to print using the Up Arrow or Down Arrow button and then press OK to 
start printing.
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Printing Using Proof Print

This section contains:
• Setting Up a Proof Print Job on page 93
• Printing a Proof Print Job on page 94

Notes:
• This special job type requires that you have a minimum of 256 MB of additional memory 

installed in the printer for a minimum total of 512 MB of RAM. For information on your printer 
configuration and available optional features, see Configurations and Options on page 22.

• The printer’s RAM Disk feature must also be enabled for you to use Proof Print. For information 
on enabling this option, see Enabling Optional Features on page 44.

The Proof Print feature enables you to temporarily store a multiple-copy print job in the printer, print 
only one set to check the print results and then, if satisfactory, print the remaining copies from the 
control panel.

Setting Up a Proof Print Job

You set up Proof Print print jobs in the printer driver at your computer. Both the PCL and PostScript 
drivers can be used for Proof Print. After setup, one copy of the job prints for you to review. Then you 
can print the rest of the copies or delete them from the printer control panel.
1. From the application you are using to print, open the Print dialog box.
2. Select your Phaser 6140 printer (PostScript or PCL printer driver) and then click the Properties 

button.
3. In the Paper/Output tab of the printer driver Properties dialog box, do the following:

a. From the Job Type list, select Proof Print.
b. If you are using the PostScript driver, click the Setup button. If you are using the PCL driver, 

click the Setting button.
c. In the Proof Print dialog box, type your name (8-character limit) in the Username field.
d. At the Retrieve Document Name field, do one of the following:

• If you want to use a specific document name to access the document from the printer 
control panel at the time of printing, select Enter Document Name. In the Document 
Name field, type the name of the document as you want it to appear on the printer control 
panel (12-character limit).

• If you want a timestamp to be displayed on the printer control panel instead of a 
document name, select Use Existing Name if you are using the PostScript driver. If you are 
using the PCL driver, select Auto Retrieve.

e. Click OK.
4. Select any other desired printing options including paper tray, paper type and paper size, and then 

click OK.

Note: Do NOT select the number of copies in the printer driver; you will do that at the control panel 
later when you print.

5. In the Print dialog box, click OK (or Print).
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6. One set of the job prints. Review this set. If the set is OK, then when you are ready to print more 
sets, go to the printer and print the rest from the control panel. For details, see Printing a Proof Print 
Job on page 94.

Printing a Proof Print Job
1. After reviewing the first set that printed when you sent the document to be printed as a Proof Print 

job type, at the printer control panel, press the Back Arrow button to access the Walk-Up printing 
feature.

2. Press the Down Arrow button to go to Proof Print and then press the OK button.
3. At your user name, or the name you supplied to use for retrieving the document when you set up 

this Proof Print job, press OK.
4. Do one of the following:

• If you selected to retrieve the document using a specific name, then at the name of the 
document, press OK.

• If you selected to retrieve the document using a timestamp, you will see Select Document and 
a time stamp displayed on the control panel menu. Press OK.

5. Select from the following:
• To print the document and then delete it from memory after printing, at Delete after Print, 

press OK.
• To print the document and keep it in the printer’s memory after printing, arrow down to Print 

and Save and then press OK.

Note: Any print jobs stored in the RAM are erased when the printer is switched off or loses power.

6. Use the Up or Down Arrow buttons to set the number of sets to print and then press OK.

See also: 
Setting Up a Proof Print Job on page 93
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Control Panel Menus

This chapter includes:
• Navigating the Control Panel Menus on page 96
• Information Pages Menu on page 97
• Billing Meters Menu on page 98
• Admin Menu on page 99
• Tray Settings Menu on page 108
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Navigating the Control Panel Menus

The following table describes the navigation and function buttons on the control panel used to select 
menu options and operate certain printer features.

Button Operation

Menu Use to access control panel menus.

OK Use to confirm menu selections and to print reports 
and lists.

Up arrow (moves cursor up)
Down arrow (moves cursor down)

Use to scroll through control panel menus and to 
increase or decrease setting increments.

Forward arrow (moves cursor to the right)
Back arrow (moves cursor to the left)

Use to scroll forward and backward through control 
panel menus. Also use the Back Arrow button to 
display the printer’s Walk-Up Features menu.

Power Saver / Wake Up Lit when in Power Saver mode. Use to wake up the 
printer from Power Saver mode or to put the printer in 
Power Saver mode.

Cancel Use to cancel the current print job.
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Information Pages Menu

Your printer comes with a set of information pages to help you track the printer’s performance and 
diagnose problems so you can obtain the best results from your printer. Access these pages from the 
printer control panel. Print the Menu Map to see where these information pages are located in the 
control panel menu structure.

See also: 
Information Pages on page 25

Information Page Contents

Menu Map Prints a list of all main and second-level menu headings that you can use to 
help you navigate the control panel menus.

Demo Page Prints an image using all printer colors to show the printer’s current ability 
to print color.

Configuration Prints information such as default printer settings, installed options, 
network settings, and font settings.

PCL Fonts List Prints information about the printer’s installed PCL fonts and prints 
samples of each.

PCL Macro List Prints a list of configured PCL macros.

PS Fonts List Prints information about the printer’s installed PostScript fonts and prints 
samples of each.

Job History Prints recent print-job history on up to the last 22 jobs.

Error History Prints information on up to the last 42 printer errors that occurred. The 
Error History Report provides a list of error messages and Chain Link codes 
relating to paper jam errors in the system (fatal errors). The printer can 
retain up to 42 jam errors and 42 system fail errors at a time.

Print Meter Prints the print meter. The print meter contains job accounting information, 
broken down by username, showing how many pages of which size were 
printed in both color and in black and white. The print meter can be reset.

Stored Document Prints a list of documents stored in the printer’s RAM when the Secure Print 
and Proof Print features are used.
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Billing Meters Menu

Billing meters display the number of processed print jobs on the printer control panel. The meters are 
divided according to the color modes. You cannot print the billing meters and you cannot reset them; 
they track the total number of pages printed for the life of the printer.

The print meter, in contrast, can be reset, and you can print the information as the Print Volume report. 
For details, see Checking Page Counts on page 121.

See also: 
Checking Print Job Status on page 117
Checking Page Counts on page 121

Item Contents

Total Impression Displays the total number of pages printed.

Color Impression Displays the total number of pages printed in color.

Black Impression Displays the total number of pages printed in black and white. Grayscale 
images printed with the composite black setting count as color pages, 
because color consumables are used. This is the default setting on most 
printers.
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Admin Menu

This section includes information about the following Admin menu sub menus:
• Network Setup Menu on page 99
• USB Setup Menu on page 100
• System Setup Menu on page 101
• Maintenance Mode Menu on page 103
• PCL Setup Menu on page 104
• PostScript Setup Menu on page 106
• Control Panel Menu on page 107

You use the Admin menu to access the printer’s configuration settings.

The following table lists the sub menus contained in the Admin Menu.

Network Setup Menu

Use this menu to configure printer settings for jobs sent to the printer via a network port.

Notes:
• The settings in the Network Setup menu cannot be selected when you enter this menu during 

printing.

• You need to restart the printer to activate menu setting changes. After making changes, switch 
off the printer and then switch it on again.

Item Description

Ethernet Specifies the Ethernet communication speed and modes.
• Auto (default): Automatically changes between 10M Half Duplex, 10M 

Full Duplex, 100M Half Duplex, and 100M Full Duplex.
• 10Base Half
• 10Base Full
• 100Base Half
• 100Base Full

TCP/IP Specifies the settings to use for the TCP/IP protocol:
• IP Mode: IPv4 Mode, IPv6 Mode, or Dual Stack
• IPv4: Get IP Address, IP Address, Network Mask, Gateway Address
• IPsec (IP security protocol; available when enabled)
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USB Setup Menu

Use this menu to configure the USB port status.

Protocol When a protocol is set to Enable, it can be used. When set to Disable, it 
cannot be used.
• LPR
• Port 9100
• IPP
• SMB TCP/IP
• SMB NetBEUI
• FTP
• WSD
• SNMP
• Email Alerts
• CentreWare IS
• Bonjour (mDNS)

Host Access List Limits the IP addresses that can access this printer.

Reset Defaults Resets all network settings back to their factory defaults.

Adobe Protocol Specifies the PostScript communication protocol to use:
• Standard
• BCP
• TBCP
• Binary
• Auto

Item Description

Port Status Use to enable or disable the USB port status. This port must be enabled for 
you to print to a USB-connected printer.
• Enable
• Disable

Adobe Protocol Specifies the PostScript communication protocol to use:
• Standard
• BCP
• TBCP
• Binary
• Auto

Item Description
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System Setup Menu

Use this menu to configure the printer’s general operation settings. For example, time to power saver 
mode, alarm settings, etc.

Item Description

PowerSaver Time Specifies the length of time, from 5 to 60 minutes, that the printer is idle 
before going into Power Saver mode. For details on setting the Power Saver 
Time, see Setting the Power Saver Time on page 24.

Audio Tones Specifies whether an alarm sounds when one of the following printer errors 
or actions occurs. These are set to Off by default. The volume cannot be 
adjusted.
• Control Panel
• Invalid Key
• Machine Ready
• Job Complete
• Fault Tone
• Alert Tone
• Out of Paper
• Low Toner Alert
• Base Tone

Fault Time-Out Specifies the amount of time that passes before the printer automatically 
deletes a print job when a there has been a job error.
Set the default time-out, up to 60 seconds, in one-second increments.

Time-Out Automatically cancels a print job when it goes beyond a specified period of 
time. Set the duration allowed for the print time. When the time expires, 
the print job is canceled. Duration can be set for up to 30 minutes in one-
minute increments.

Language Specifies the language used in the control panel menus and in printed 
Information pages.



Control Panel Menus

Phaser 6140 Color Laser Printer
User Guide

102

Auto Log Print Specifies whether to automatically print a Job History Report after 22 print 
jobs.
• Off (default): Prevents the Job History Report from printing 

automatically even if the number of print jobs exceeds 22.
• On: Automatically prints a report when the number of print jobs reaches 

22.

Notes:
• You cannot set this during printing.

• After changing this setting, turn off the printer and then turn 
it on again to activate the change.

Print ID Prints the user ID in the specified place on the printed page.
• Off (default): The user ID is not printed.
• Top Left: Prints the user ID on the top left of the page.
• Top Right: Prints the user ID on the top right of the page.
• Bottom Left: Prints the user ID on the bottom left of the page.
• Bottom Right: Prints the user ID on the bottom right of the page.

Print Text Specifies whether the printer outputs unsupported PDL data as text when 
the printer receives it. Text data is printed on A4- or Letter-size paper.

RAM Disk This feature is available when the printer’s memory is expanded from 256 
MB to at least 512 MB RAM.
Allocates memory to the RAM Disk file system for the Secure Print, Collating 
Jobs, and Proof Print, Form Overlay, and Font Download features.
• Enable
• Disable (default)

Size Mismatch Specifies how the printer reacts when it detects a difference between the 
size of paper specified at the control panel and the size loaded in the 
specified destination tray. Or, in the case where the paper in the specified 
tray runs out, the printer will select the substitute tray based on the Size 
Mismatch settings.
When a Paper Type other than None is selected in the printer driver, it 
overwrites the Size Mismatch setting on the control panel.
• Off (default): The printer will prompt you to select a tray for printing.
• Larger Size: The printer will use a tray that has paper larger than the 

size specified for the print job but will print the page at 100% 
magnification.

• Nearest Size: The printer will use a tray that has paper nearest to the 
size specified in the print job. The page will print at 100% 
magnification.

mm/inch Specifies the units of measurement to use for the custom paper sizes:
• Millimeters (mm)
• Inches

Default Size Specifies the default paper size as either A4 or Letter.

Item Description



Control Panel Menus

Phaser 6140 Color Laser Printer
User Guide

103

Maintenance Mode Menu

Use this menu to configure color registration and to reset defaults.

Startup Page Automatically prints the Configuration page when the printer is turned on.
• On
• Off

Odd Page 2Sided
(Phaser 6140/ND printer 
configuration only)

If the optional duplex unit is installed, this specifies the process for the last 
odd page in a 2-sided print job.
• 1 Sided
• 2 Sided

Power On Wizard Resets the Power On Wizard. The first time the printer is turned on, a special 
menu appears on the printer control panel you can use to configure certain 
initial settings such as language, default paper size, and network settings. 
The Power On Wizard setting enables the administrator to reset the Power 
On Wizard so that the next time the printer is turned on, this special menu 
appears.

Item Description

F/W Version Displays the current firmware version installed in the printer.

Auto Regi Adj. Auto Registration Adjust. When On (the default), the color registration is 
adjusted automatically.

Adjust Color Regi. Adjust Color Registration. Used to correct the color registration. For details, 
see Color Registration on page 143.
• Auto Adjust: Use to force an automatic color registration correction.
• Color Regi Chart: Prints the color registration chart used to check for 

correct color registration.
• Enter Number: Use to select and correct color registration numbers. 

Fast Scan (1): For setting horizontal color registration, or Slow Scan (2) 
for setting vertical color registration.

Clear Developer Resolves print-quality defects associated with charge problems after 
high-coverage print jobs.

Toner Refresh Resolves print-quality defects associated with charge problems after 
low-coverage jobs.

Item Description
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PCL Setup Menu

Use this menu to configure settings for the Printer Command Language (PCL). The printer’s PCL driver 
is used for applications requiring PCL. For PCL printer driver options, see Printing Options for Windows 
PCL Driver on page 68.

Drum Refresh Helps improve imaging unit performance after overexposure to light.

Init Print Meter Initialize Print Meter. Resets the Print Meter.

Initialize NVM Resets the settings in the nonvolatile memory (NVM), except for the 
network settings, to their defaults. NVM is memory that stores the printer 
settings even after the power is turned off. After selecting this option and 
restarting the printer, all the menu parameters are reset to their default 
values.

Notes:
• You cannot set this during printing.

• After changing this setting, turn off the printer and then turn 
it on again to activate the change.

Clear Storage Deletes documents stored in the printer’s RAM.

Reset Fuser Resets the fuser life counter to the starting point (0).

Item Description

Paper Tray Specifies the paper tray to use when the Paper Tray setting in the PCL 
printer driver is set to Auto Select.
• Auto (default)
• Tray 1
• Tray 2 (optional; if installed)
• Manual Feed Slot

Paper Size Specifies the default paper size to print.

Orientation Specifies the default paper orientation:
• Portrait (default)
• Landscape

2-Sided Specifies 2-sided printing settings:
• 2-Sided Print: Specifies whether to perform 2-sided printing. The 

default is Off.
• Binding Edge: Specifies the binding direction from Flip Long Edge 

(default) or Flip Short Edge.

Font Specifies the font to use. The default font is Courier.

Item Description
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Symbol Set Specifies the font to use for symbols. The default is Roman-8.

Font Size Specifies the font size. The default size is 12.00. You can specify a value 
between 4.00 and 50.00 in increments of 0.25. Available only for 
typographic fonts.

Font Pitch Specifies the character spacing. You can specify a value between 6.00 and 
24.00 in increments of 0.01. The default is 10.00. 

Form Line Specifies the form line (the number of lines per form). You can specify a 
value between 5 and 128 in increments of 1. The default is 60.

Quantity Specifies the number of copies to print. You can specify a value between 1 
to 999. The default is 1.

Image Enhance Selects whether to perform image enhancement.
The image enhancement feature makes the boundary line between black 
and white smoother to decrease jags and enhance the visual appearance. 
• On (default)
• Off

Hex Dump Specifies whether to print the data sent from a computer in the ASCII code 
corresponding to the hexadecimal notation format in order to check the 
data contents. 
• Enable
• Disable (default)

Draft Mode Specifies whether to print in draft mode. 
• Enable
• Disable (default)

Line Termination Allows the administrator to manually configure what line endings will be 
used when printing PCL or text files.
• Off: Line termination commands are not added.
• Add-LF: The Line Feed command is added.
• Add-CR: The Carriage Return command is added.
• CR-XX: The Line Feed and Carriage Return commands are both added.

Default Color Specifies the default color mode:
• Black (default)
• Color

Item Description
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PostScript Setup Menu

Use this menu to configure settings for the PostScript driver. The printer’s PS driver is used for 
applications requiring PostScript. For PS driver options, see Printing Options for Windows PostScript 
Driver on page 66 and Printing Options for Macintosh OS X on page 70.

Item Description

PS Error Report Turns error reporting on or off.
The default is On.

PS Job Time-Out Turns the time-out off, or selects the length of time before timing out. The 
default is Off.
If you interrupt a print job at the source (computer) by canceling, or the 
network connection is lost and not all of the print job file gets sent to the 
printer, the timeout allows the printer to stop working on the canceled job 
and switch to another waiting print job.

Paper Select Mode Specifies how the printer handles tray switching if, during a print job, the 
selected tray runs out of paper. Tray settings in the PostScript printer driver 
can override this setting.

Default Color Specifies the default color mode:
• Color (default)
• Black
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Control Panel Menu

Use this menu to control access to the printer settings via a password.

Item Description

Panel Lock Specifies whether to limit the menu operations with a password:
• Enable: Requires the operator to enter the password. If On is set, then 

you must enter the password to use the Admin Menu.
• Disable (default): All menus are accessible.

Change Password Enabled when Panel Lock is enabled. Use to change the Panel Lock 
password for access to the Admin Menu on the control panel.
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Tray Settings Menu

Use this menu to configure settings for each of the printer’s paper trays.

Notes:
• When the size or type of paper loaded in the trays is different from the setting, the print quality 

may be reduced or the paper may jam in the printer. Specify the correct paper type and size.

• When the optional 250-sheet feeder (Tray 2) is installed, if the Paper Tray setting in the PCL 
driver is set to Auto Select, the tray used for printing will be the one set up at the printer control 
panel in the PCL Setup menu. For details, see Printing Options for Windows PCL Driver on 
page 68. If the Paper Tray setting in the PostScript driver is set to Auto Select, the tray used for 
printing will be the one set up at the printer control panel in the PostScript Setup menu. For 
details, see Printing Options for Windows PostScript Driver on page 66.

• When the paper size and type setting for each tray is the same, if the paper runs out in the 
specified tray, printing continues by changing to the other tray if it is installed.

Tray 1 Settings

Menu Item Contents

Paper Type Specifies the type of paper loaded in the tray.

Paper Size Specifies the paper size and orientation of the paper in the tray.
• Letter
• US Folio
• Legal
• Executive
• Monarch Env.: Use this setting for feeding Monarch envelopes short 

edge first.
• Monarch Env. L: Use this setting for feeding Monarch envelopes long 

edge first.
• DL Env.: Use this setting for feeding DL envelopes short edge first.
• DL Env. L: Use this setting for feeding DL envelopes long edge first.
• C5 Env.
• #10 Env.
• New Custom Size: Use to preset the custom size of paper loaded into 

the tray so that if you print from the printer driver but have Auto Select 
set in the driver’s Paper Tray field, the job will print without your 
intervention. The printer will compare the size set in the driver with the 
sizes set for its trays and use the tray in which it finds the correct size 
paper.

• A4
• A5
• B5
For measurements, see Usable Paper on page 52.
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250-Sheet Feeder (Tray 2) Settings

Display Popup Displays a message that prompts you to set the paper size and type every 
time you load paper in the tray.
• On: A message prompts the user to set the paper size and type.
• Off (default): No message is displayed.

Menu Item Contents

Paper Type Specifies the type of paper loaded in the tray.
• Plain
• Letterhead
• Prepunched
• Colored Paper

Paper Size Specifies the paper size and orientation of the paper in the tray.
• Letter
• US Folio
• Legal
• Executive
• New Custom Size
• A4
• A5
• B5

Display Popup Displays a message that prompts you to set the paper size and type every 
time you load paper in the tray.
• On: A message prompts the user to set the paper size and type.
• Off (default): No message is displayed.

Menu Item Contents
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Maintenance

This chapter includes:
• Cleaning the Printer on page 112
• Ordering Supplies on page 114
• Managing the Printer on page 116
• Checking Page Counts on page 121
• Moving the Printer on page 123
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Cleaning the Printer

This section includes:
• General Precautions on page 112
• Cleaning the Exterior on page 112
• Cleaning the Interior on page 113

General Precautions
Warning: When cleaning your printer do NOT use organic or strong chemical solvents or aerosol 
cleaners. Do NOT pour fluids directly into any area. Use supplies and cleaning materials only as 
directed in this documentation. Keep all cleaning materials out of the reach of children.

Warning: Internal parts of the printer may be hot, especially the fuser. Use caution when doors 
and covers are open.

Warning: Do NOT use pressurized air-spray cleaning aids on or in the printer. Some pressurized air-
spray containers contain explosive mixtures and are not suitable for use in electrical applications. 
Use of such cleaners can result in a risk of explosion and fire.

Warning: Do NOT remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do NOT attempt any maintenance 
procedure that is NOT specifically described in the documentation supplied with your printer.

To avoid damaging the printer, keep the following guidelines in mind:
• Do not place anything on top of the printer.
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the imaging units.
• Do not open covers and doors during printing.
• Do not tilt the printer while in use.
• Do not touch the electrical contacts, gears, or laser devices. Doing so may damage the printer and 

cause the print quality to deteriorate.
• Make sure any parts removed during cleaning are reinstalled before you plug in the printer.

Cleaning the Exterior

Clean the exterior of the printer about once a month. Wipe the parts with a damp, soft cloth. Then 
wipe with another dry soft cloth. For stubborn stains, apply a small amount of neutral detergent to the 
cloth and gently wipe the stain off.

Caution: Do not spray the detergent directly on the printer. The liquid detergent may enter the 
printer through a gap and cause problems. Never use cleaning agents other than water or neutral 
detergent.
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Cleaning the Interior

After clearing paper jams or replacing one of the toner cartridges, inspect the inside of the printer 
before closing the printer covers.

Remove any remaining pieces of paper. For more information, see Clearing Paper Jams on page 147.

Remove any dust or stains with a dry, clean cloth.

Warning: Never touch a labeled area found on or near the heat roller in the fuser. You can get 
burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it by yourself to 
avoid injuries or burns. Switch off the printer immediately and wait 40 minutes for the fuser to cool.

1. Fuser

2. Transfer belt unit

6140-022

1

2
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Ordering Supplies

This section includes:
• Consumables on page 114
• Routine Maintenance Items on page 114
• When to Order Supplies on page 114
• Recycling Supplies on page 115

Consumables

Use only genuine Xerox Toner Cartridges (Cyan, Magenta, Yellow, and Black).

Notes:
• Each toner cartridge includes installation instructions.

• Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner 
remaining amount displayed may not be accurate.

• To enhance print quality, the toner cartridges have been designed to cease functioning at a 
predetermined point.

Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements may be parts or kits. Routine maintenance items are typically customer replaceable:
• Fuser
• Feed roller kit
• Imaging unit

Note: Although the transfer belt unit is not considered a routing maintenance item, if it becomes 
damaged, you can order another one. You can also order a duplex unit.

When to Order Supplies

The printer control panel displays a warning when a supply nears its replacement time. Verify that you 
have replacements on hand. It is important to order these supplies when the messages first appear to 
avoid interruptions to your printing. The control panel displays an error message when the supply must 
be replaced.

To order supplies, contact your local reseller or go to the Xerox Supplies website at 
www.xerox.com/office/6140supplies.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreements, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of 
performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this 
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage 
may vary outside these areas; please contact your local representative for details.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=order&Language=english
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Recycling Supplies

For information on recycling supplies, go to www.xerox.com/gwa.

See also: 
Recycling and Disposal on page 163

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=recyclesupplies&Language=english
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Managing the Printer

This section includes:
• Managing the Printer with CentreWare IS on page 116
• Checking Printer Status with PrintingScout on page 117
• Checking Printer Status via Email on page 118

Managing the Printer with CentreWare IS

This section includes:
• Accessing CentreWare IS on page 116
• Checking the Printer’s Status on page 116
• Checking Print Job Status on page 117
• Using Online Help on page 117

CentreWare IS enables you to check printer status and configure settings using a Web browser on a 
network computer. You can also use CentreWare IS to check the remaining volume of consumables and 
the paper loaded in the printer.

Notes:
• This section applies to Phaser 6140/N or /DN printer configurations connected to a network. A 

USB-only connection will not give you access to CentreWare IS. If you do not have a network 
connection to the printer, you can use PrintingScout. For details, see Checking Printer Status with 
PrintingScout on page 117.

• CentreWare IS requires a Web browser and a TCP/IP connection between the printer or device 
and the network (in Windows or Macintosh environments). TCP/IP and HTTP must be enabled in 
the printer, and a browser that supports Java Script is required. If Java Script is disabled, a 
warning message appears and CentreWare IS may not function properly.

Accessing CentreWare IS

To access CentreWare IS:
1. Verify that your printer is turned on.
2. Launch your computer’s Web browser and then enter your printer’s IP address in the address field 

using this format: http://xxx.xxx.xxx.xxx. Do not type “www” before the IP address.
Your printer’s CentreWare IS page opens in the browser.

Checking the Printer’s Status
1. In CentreWare IS, click the Status button (or, if you are in a different tab, click the Status tab).

The printer’s general status includes:
• The type, size, and amount (empty or full) of paper in each tray.
• The printer’s ready-for-printing status.
• The frequency with which the printer status information is refreshed.
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• The total page count of printed pages.
2. To check the printer’s supplies status, in the Status tab, click the Supplies button.

The printer’s supplies status includes:
• The amount remaining in each toner cartridge.
• The percentage remaining of the imaging unit’s life.

Checking Print Job Status

CentreWare IS keeps a log of current print jobs, including the name of the document, the person who 
submitted the print job, the job status, and more. You can also get a list of all print jobs.
1. To view the status of print jobs sent to the printer, in CentreWare IS, click the Jobs button (or Jobs 

tab if you are in another tab of CentreWare IS).
2. To view a job history list, in the Jobs tab, in the navigation pane on the left of the page, expand the 

History List link and then click Job History.

Using Online Help

For details about settings in CentreWare IS, click the Help button. For other support information, click 
the Support button (or tab).

Checking Printer Status with PrintingScout
Note: PrintingScout is a Windows-only application.

The PrintingScout utility automatically checks the printer status when you send a print job. 
PrintingScout can check the paper size that is loaded in the trays, the status of the output tray, and the 
remaining amount of consumables such as toner cartridges.

To open PrintingScout, do one of the following:
• In the Windows taskbar, double-click the PrintingScout icon.
• From the Start menu, select Programs > Xerox Office Printing > PrintingScout > Activate 

PrintingScout.
The printer’s status is displayed in the Status column of the Select Printer dialog box that opens.

For information on using PrintingScout, see the PrintingScout help: in the Windows Taskbar, right-click 
the PrintingScout icon and select Help.

See also: 
Installing PrintingScout on page 43
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Checking Printer Status via Email

This section includes:
• Configuring Email Alerts on page 118
• Commands That Can be Used in Email Text on page 119

If you are working in a network environment where you can send and receive email, and the printer is 
connected to the network, you can configure the printer to email you reports about the printer:
• The network settings and the printer status.
• The errors that occur on the printer.

Configuring Email Alerts

In CentreWare IS, configure the following settings according to your email environment. After 
configuring the settings on each page, always click Save Changes and then restart the printer by 
turning it off and then on. For details about each item, refer to the Online Help for CentreWare IS.
1. Launch your Web browser and type your printer’s IP address in the browser address field.
2. In the printer’s CentreWare IS page, click the Properties button.
3. In the navigation pane on the left side of the page, click the Mail Alerts link.
4. In the Mail Alerts page, select the Enable Mail Alerts check box if it is not already selected.
5. In the SysAdmin Mail Address field, type your email address or the address to which you want 

email alerts sent.
6. In the Notification Items section, select the events for which you would like to be notified.
7. In the Connection Setup box, click the Email Server link.

The Email Server page opens.
8. In the Email Server Setup (Required to send Email) section, do the following:

a. In the Return Email Address field, type the return address used by the email server.
b. In the SMTP Server (IP Address or DNS Name) field, type the outgoing IP address used by your 

SMTP server for sending email.

Note: If you are unsure of the address, or DNS name if you are connecting using that, contact your 
Internet Service Provider (ISP) for the correct address information.

c. In the SMTP Port field, type the number of the port used. The default is 25.
9. In the Email Send Authentication section, do one of the following:

• If no authentication in necessary, select No Authentication in the Authentication Type field.
• If authentication is required, complete the fields as needed.

10. In the Email Server Setup (Required to receive Email) section, enter the appropriate information in 
the fields as needed.

11. In the Email Filter (Filters Email Received by the device) section, enter the email addresses of the 
users who are permitted to send email to the printer. If no address is specified here, the printer can 
receive email from all users.

12. In the Email Password (Password for remote status) section, to set the password for access to the 
printer, both read only and read/write, enter a password in the Password field and then enter it in 
the Re-enter Password field.
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13. Click the Save Changes button.
14. In the navigation pane on the left side of the page, click Port Enabling and then select the check 

boxes for the ports to enable. Be sure to enable at least the Enable Mail Alerts port.
15. Click the Save Changes button.

Commands That Can be Used in Email Text
Notes:
• You can specify any title for the email when checking the printer status or changing the printer 

settings.

• Use the commands described in the next section to create the text of the email.

Use each command according to the following rules.
• Prefix all commands with the pound sign (#), and specify the #Password command at the top of 

the email.
• Command lines without the pound sign (#) are ignored.
• Write one command on each line and separate each command and parameter with a space or a 

tab.

When the same command is written two or more times in one e-mail, the second and subsequent 
commands are ignored.

Example of Commands
• When the read-only password is “ronly” (for “read only”), and to check the printer status:

#Password ronly
#Status

• When the full access password is “admin”, and to set the recipient e-mail address to 
“service@xerox.com”:
#Password admin

Command Parameter Description

#Password Password Use this command at the top of the 
email when a password for read only or 
full access is set. You can omit this 
command when the password is not set.

#NetworkInfo Set this when you want to check 
information on the network settings list.

#Status Set this when you want to check the 
printer status.

#SetMsgAddr Recipient Email address Use this command to specify the e-mail 
address to which e-mail reports are sent 
to. This command can only be used 
when the full access password is 
specified by the #Password command.
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#SetMsgAddr service@xerox.com
• When the full access password is “admin”, and to set the recipient e-mail address to 

“service@xerox.com”, then confirm the setting result on the network settings list:
#Password admin
#SetMsgAddr service@xerox.com
#NetworkInfo

Note: Describe the #SetMsgAddr command before the #NetworkInfo command. If they are 
written in reverse, the information retrieved by the #NetworkInfo command and the result of 
executing the #SetMsgAddr command may differ.
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Checking Page Counts

This section includes:
• Viewing the Billing Meter on page 121
• Printing the Print Volume Report on page 121

You can check the total number of printed pages at the printer control panel, on the Configuration 
page, and in CentreWare IS. Three meters are available: Total Impressions, Color Impressions, and 
Black Impressions. The billing meter counts the number of pages printed properly. Single-side print, 
including N-up, is counted as one impression, and 2-sided print, including N-up, is counted as two. 
During 2-sided printing, if an error occurs after one side is printed properly, it is counted as one.

When printing color data that has been converted using an ICC profile on an application with the Color 
(Auto) setting, the data is printed in color even if it seems to be black and white data on the monitor. In 
that case, the number of Color Impressions is increased.

Note: Grayscale images printed with the composite black setting count as color pages because 
color consumables are used. This is the default setting on most printers.

When doing automatic 2-sided printing, a blank page may be inserted automatically depending on the 
settings in the application. In this case, the blank page is counted as one page.

Viewing the Billing Meter

The billing meter tracks the total number of pages printed for the life of the printer; it cannot be reset.

To check the total number of pages printed:
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Billing Meters and then press the OK button.
3. Arrow down to the desired meter. The number of printed pages is displayed below the name.
4. After checking, press the Menu button to exit the Billing Meters menu.

Printing the Print Volume Report

The print meter tracks print job accounting information. The information is available in the Print 
Volume report, which shows the information broken down by username and by how many pages of 
which size were printed in color and in black and white.

To print the print meter information page:
1. On the printer control panel, press the Menu button.
2. At Information Pgs, press the OK button.
3. Press the Down Arrow button to go to Print Meter and then press OK.

The Print Volume Report prints.
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See also: 
Information Pages on page 25
Managing the Printer with CentreWare IS on page 116
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Moving the Printer

Follow these procedures when moving the printer.

To view precautions and guidelines for safely moving your printer, see Safety on page 9.

The printer, with Tray 1 and consumables but without the optional duplex unit or 250-sheet feeder, 
weighs 18.6 kg (41 lb.). Configured with the optional duplex unit and 250-sheet feeder, the printer 
weighs 24.2 kg (53.24 lb.).

Before moving the printer, do the following:
1. Turn the printer off and disconnect the power cord and other cables from the back of the printer.

Warning: To prevent electric shock, never touch the power plug with wet hands. When removing 
the power cord, make sure that you pull the plug and not the cord. Pulling the cord can damage it, 
which can lead to fire or electrical shock.

2. Wait for the printer to cool down, about 40 minutes.
3. Remove any paper or other media from the output tray and return the paper stopper to its original, 

non-extended position.
4. Remove Tray 1 and set it aside.

Note: If the printer is to be moved over a long distance, the toner cartridges should be removed to 
prevent toner from spilling, and the printer should be packed inside a box.

5. If your printer configuration includes the 250-sheet feeder, remove it and its lower feeder unit by 
lifting the printer off it.

Warning: If the optional 250-sheet feeder has been installed, uninstall it before moving the 
printer. If these are not fixed securely to the printer, they may fall to the ground and cause injuries. 
For details on how to uninstall the options, refer to the instruction sheet that is bundled with each 
option.

Warning: To avoid injury, use two people to lift the printer off the lower feeder unit.
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When moving the printer:
• Always use two people to lift and move the printer.
• When lifting the printer, grasp the areas as shown in the illustration.

• Do not tilt the printer more than 10 degrees to the front or back, or left or right. Tilting the printer 
more than 10 degrees may cause toner spillage.

Caution: Failure to repackage the printer properly for shipment can result in damage to the printer 
not covered by the warranty, Service Agreement, or Total Satisfaction Guarantee.

After moving the printer:
1. Reinstall any parts you removed. If you removed the 250-sheet feeder, put the printer back on top 

of it.
2. Reconnect the printer to the cables and power cord.
3. Plug in and turn on the printer.
4. Adjust the color registration before using the printer. For details, see Color Registration on 

page 143.

18.6 kg
41 lb.

6140-027

Note: Configured with 
the optional duplex unit 
and 250-sheet feeder, 
the printer weighs 24.2 
kg (53.24 lb.).
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Troubleshooting

This chapter includes:
• Troubleshooting Overview on page 126
• Control Panel Messages on page 128
• Problems with the Printer on page 132
• Print-Quality Problems on page 135
• Cleaning the Imaging Unit and Laser Lens on page 140
• Color Registration on page 143
• Paper Jams on page 146
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Troubleshooting Overview

This section includes:
• Error and Status Messages on page 126
• PrintingScout Alerts on page 126
• Online Support Assistant on page 126
• Information Pages on page 126
• Web Links on page 127

Your printer comes with a number of utilities and resources to help you troubleshoot printing problems.

Error and Status Messages

The printer control panel provides you with information and troubleshooting help. When an error or 
warning condition occurs, the control panel displays a message informing you of the problem.

For details, see Control Panel Messages on page 128.

PrintingScout Alerts

The PrintingScout utility automatically checks the printer status when you send a print job. If the 
printer is unable to print your job, PrintingScout automatically displays an alert on your computer 
screen to let you know that the printer needs attention. You install PrintingScout from the Software and 
Documentation CD that came in the documentation packet with your printer. For details, see Installing 
PrintingScout on page 43.

Note: PrintingScout is a Windows-only application.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help 
to solve your printer problems. You can find solutions for print-quality problems, media jams, software 
installation, and much more.

To access the Online Support Assistant, go to www.xerox.com/office/6140support.

Information Pages

Two of the printer’s internal pages, the Demo page and the Error History report, can help with 
troubleshooting certain problems. The Demo page prints an image using all printer colors to show the 
printer’s current ability to print. The Error History report prints information on up to the last 42 printer 
errors that occurred.

To print information pages:
1. On the printer control panel, press the Menu button.
2. At Information Pages, press the OK button.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=knowledgebase&Language=english
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3. Press the Down Arrow button to go to the desired page and then press OK.

Web Links

Xerox provides several websites that offer additional help for your Phaser 6140 printer. A set of Xerox 
links is added to your Web browser’s Favorites folder when you install a Xerox printer driver on your 
computer.

Resource Link

Technical support information for your printer. 
Includes online Technical Support, Recommended 
Media List, Online Support Assistant, driver 
downloads, documentation, video tutorials, and 
more.

www.xerox.com/office/6140support

Supplies for your printer www.xerox.com/office/6140supplies

A resource for tools and information such as 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual 
needs.

www.xerox.com/office/businessresourcecenter

Contacts www.xerox.com/office/worldcontacts

Printer registration www.xerox.com/office/register

Material Safety Data Sheets identify materials and 
provide information on safely handling and storing 
hazardous materials.

www.xerox.com/msds
(U.S. and Canada)
www.xerox.com/environment_europe
(European Union)

Information about recycling supplies www.xerox.com/gwa

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=businessresourcecenter&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=order&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=reg&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=msdsna&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=msdseu&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=recyclesupplies&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=customersupport&Language=english
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Control Panel Messages

This section includes:
• Supply Status Messages on page 128
• Error Messages on page 129

The printer uses control panel messages to indicate printer status, errors, and to provide instructions.

Supply Status Messages

Status messages tell you about the status of the printer and its supplies.

Note: XXX indicates one of the following: the Yellow Toner (Y), Cyan Toner (C), Magenta Toner (M), 
Black Toner (K), a tray, or fuser. NNN indicates a numeric value.

Code/Message Condition/Reason/Action

Replace Fuser
010-351

Time to replace the fuser.
Replace the old fuser with a new one and then restart the printer.

Insert Fuser
010-317

The fuser is not installed or it is incorrectly installed.
Install the fuser and then restart the printer.

Replace Imaging Unit It is time to replace the imaging unit.
Replace the imaging unit. For details, see the Imaging Unit instruction 
sheet that came in the documentation packet with your printer.

Insert Imaging Unit The imaging unit is not installed.
Install the imaging unit. For details, see the Imaging Unit instruction sheet 
that came in the documentation packet with your printer.

Insert XXX Cartridge The XXX toner cartridge is not installed correctly or is not installed. Install 
the toner cartridge.

Replace XXX Cartridge The toner cartridge has become empty.
Replace the old toner cartridge with a new one.

Invalid XXX A toner cartridge for another region is installed, or the toner cartridge is not 
seated correctly. Reseat the toner cartridge or replace the cartridge with 
one that meets specifications for your printer. Your printer’s region is listed 
on the Configuration page in the General section. For details on printing 
the Configuration page, see Configuration Page on page 25.

Non-Xerox Toner The printer is in the custom toner mode. This means a non-Xerox toner is 
installed. You may experience a decrease is print quality as a result.

Low Density
XXX Cartridge

Toner is not distributed evenly in the specified cartridge. Remove and shake 
the cartridge, then reinstall it.
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Error Messages

XXX Low The toner in the specified cartridge is low and will need to be replaced 
soon.
Purchase a new cartridge. For details, see Ordering Supplies on page 114.

Waste Full
XXX Cartridge

Replace the specified toner cartridge.

Tray XXX Empty The specified tray is out of paper. Open the tray, insert paper, and then 
close the tray.

Message Condition/Reason/Action

Fuser Error
Error 010-397

Check that the fuser is seated correctly, then restart the printer.

Check Unit
Imaging Unit

Sealing tape is still attached to the imaging unit. Remove the tape.

Over Heat
Please Wait
Error 042-700
Please Wait

The printer’s internal temperature is too high.
The printer has been stopped.
Wait 1 hour before restarting the printer. Ensure the printer has adequate 
cooling space around it, and that the cooling vents are not blocked.

Jam at Tray 1
Check Tray 1
Open Front Cover

Paper is jammed inside the paper tray.
Remove the jammed paper and then open and close the front cover. For 
details, see Clearing Jams at Tray 1 on page 147.

Jam at Tray 2
Check Tray 2
Open Front Cover

Paper is jammed inside the paper tray.
Open Tray 2 and remove the jammed paper.
Open and close the front cover. For details, see Clearing Jams at the 250-
Sheet Feeder on page 149.

Chk Manual Feed
Remove Paper
Open and close Front Cover

There is a jam at the manual feed slot. Remove the paper and then open 
and close the front cover. For details, see Clearing Jams at the Manual Feed 
Slot on page 148.

Remove paper from Manual 
Feed

Remove the paper at the manual feed slot.

Jam at Front Cover
Open Front Cover and Remove 
Paper

Paper is jammed inside the printer.
Press the button to open the front cover and then remove the jammed 
paper.

Jam at Duplexer
Open Front Cover
Lift Transfer Unit

There is a paper misfeed at the duplex unit.
Press the button to open the front cover and then remove the jammed 
paper. For details, see Clearing Jams at the Duplex Unit on page 150.

Code/Message Condition/Reason/Action
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Jam at Exit
Open Front Cover
and Remove Paper

Paper is jammed inside the printer.
Open the front cover and remove the paper.

Jam at Reg. Roll
Open Front Cover

There is a paper misfeed at the registration roller that helps line the paper 
in the printer path. Open the front cover and remove the paper.

Reseat Paper of Manual Feed Remove and then reseat the paper in the manual feed slot.

Load Manual Feed Load the correct-size paper in the manual feed slot.

Load Tray XXX The printer has detected a paper size mismatch or no suitable paper is 
loaded in any of the trays.
Open the specified tray, remove the paper, insert paper of the correct size 
and then close the tray.

Insert Output to Tray XXX Waiting for side 2 to be set for manual 2-sided printing. Set side 2 sheet to 
the specified tray.

Side Door Open
Close Side Door

The side door (to the toner) is open. Close the side door.

Front Cover Open
Close Front Cover

The front cover is open.
Close the front cover.

Invalid Job
Press OK Button
Error 016-799

When the printer configuration on the printer driver does not conform to 
the printer you are using, this message is displayed.
Press the Cancel button to cancel the print job.
Make sure that the configuration of the printer on the printer driver 
conforms to the printer you are using.

Out of Memory
Press OK Button
Error 016-718

The printer memory is full and cannot continue processing the current print 
job.
• Press the OK button to clear the message, cancel the current print job, 

and conduct the next print job, if any.
• Press the Cancel button to cancel the print job.
• Press the Left Arrow button to open the Walk-Up Features menu and 

delete the job being held.
• If the problem has not been corrected, turn the printer off and then on 

again.
To avoid this error in the future, do the following:
• Delete unnecessary fonts, macros, and other data in printer memory.
• Install additional printer memory.

Collate Full
Press OK Button
Error 116-721

The memory for the collate function is full; press OK and then turn the 
printer off and then on to clear any pending jobs. Also check your 
computer’s print queue to make sure the jobs are deleted from there. Then 
try sending the job again. If you still get the error message, repeat the 
process of pressing OK and turning the computer off and on and clearing 
the print queue, and then send the print job in smaller batches. If this does 
not work, contact technical support.

Message Condition/Reason/Action
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PDL Error
Press OK Button
Error 016-720

An error relating to PCL emulation has occurred.
Press the OK button to clear the message, cancel the current print job, and 
conduct the next print job, if any.
Press the Cancel button to cancel the print job.

Message Condition/Reason/Action



Troubleshooting

Phaser 6140 Color Laser Printer
User Guide

132

Problems with the Printer

If you encounter a problem with your printer, use the following table to troubleshoot and fix the 
problem. For additional troubleshooting information, see Troubleshooting Overview on page 126.

Warning: Never open or remove printer covers that are secured with screws unless specifically 
instructed in the manual. A high-voltage component can cause electric shock. Do not try to alter 
the printer configuration or modify any parts. An unauthorized modification can cause smoke or 
fire.

Caution: Probable causes of trouble are that the printer, computer, server, or other hardware is not 
correctly set for the network environment you are using, or a printer restriction has been exceeded.

Symptom Reason/Action

No power. Is the power to the printer turned off?
Press the power button to the On position to turn on the power.

Is the power cord disconnected or not securely connected?
Turn off the power to the printer and then connect the power cord to the 
power outlet again. Then turn on the power to the printer.

Is the power cord connected to a power outlet with the correct voltage?
Connect the printer exclusively to a power outlet with a suitable voltage 
and current rating. For details, see Electrical Specifications on page 156.

Is the printer connected to an uninterruptable power supply?
Turn off the power to the printer and then connect the power cord to a 
suitable power outlet.

Is the printer connected to a power strip shared with other high-power 
devices?
Connect the printer to a power strip that is not shared with other 
high-power devices.

Cannot print. Is the light of the Ready indicator off?
If so, this printer is in Power Saver mode or in the menu setting mode. For 
details, see Control Panel on page 21.

Is there a message displayed on the control panel?
Read the message and follow the instructions to correct the problem. For 
details, see Control Panel Messages on page 128.
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Print job sent but the light of 
the Ready indicator is not 
blinking or on.

Is the interface cable (Ethernet or USB) disconnected?
Turn off the power and check the connection of the interface cable.

Is the protocol configured?
Check the port status of the interface. Make sure the protocol settings are 
correctly configured in CentreWare IS. For details, see the online help for 
CentreWare IS.

Is the computer environment correctly set up?
Check the computer environment, such as the printer driver. For details, see 
Installation and Setup on page 29.

Error indicator is on. Is there an error message displayed on the control panel?
Check the displayed message and correct the error. For details, see Control 
Panel Messages on page 128.

Error indicator is blinking. An error has occurred that you cannot correct by yourself.
Record the displayed error message or error code, turn off the power and 
disconnect the power plug from the outlet. Refer to the Xerox Support 
website, www.xerox.com/office/6140support.

Light of the Ready indicator is 
on and blinking but there is no 
print output.

There are jobs remaining in the printer.
Cancel printing or force the remaining data to be printed.
To forcibly print the job, press the OK button. To cancel the job, press the 
Cancel button.

Top section of printed 
document is missing. The top 
and side margins are incorrect.

Are the paper tray guides in the correct positions?
Set the length guide and the width guides to the correct positions. For 
details, see Loading Paper on page 55.

Check that the paper size on the printer driver or the control panel is 
correctly set. For details, see Setting Paper Types and Sizes on page 62.
For details, see the online help for the printer driver.

Check that the margin setting is correct on the printer driver. (PCL only).
For details, see the online help for the printer driver.

Condensation has occurred 
inside the printer.

Turn the printer on and leave it on for at least one hour to get rid of the 
condensation. If the problem continues, refer to the Xerox Support website, 
www.xerox.com/office/6140support.

Symptom Reason/Action

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=tech&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=tech&Language=english
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Paper cannot be fed.
Paper jams.
Multiple sheets are fed. Paper is 
fed at an angle.
Paper is wrinkled.

Is the paper correctly loaded?
Load the paper correctly. For labels or envelopes, fan them well to allow air 
to enter between each sheet before loading. For details, see Loading Paper 
on page 55.

Is the paper damp?
Replace with paper from a new ream. For details, see Paper Storage 
Guidelines on page 51, and Paper Usage Guidelines on page 50.

The paper used is not suitable.
Load the correct type of paper. For details, see Supported Paper and Media 
on page 50.

Is the paper tray set correctly?
Push the paper tray completely into the printer.

Is the printer placed on a flat location?
Place the printer on a stable, flat surface.

Are the paper tray guides set in the correct positions?
Set the guides to the correct positions. For details, see Loading Paper on 
page 55.

Paper is fed more than 1 sheet at a time.
Multiple feeding of paper may occur before the sheets of paper loaded in 
the tray are used up. Remove the paper, fan it, and load again. Replenish 
paper only when all the sheets of the loaded paper are used up.

Unusual noises. The printer is not level.
Reposition the printer on a flat, stable surface.

The paper tray is not inserted properly.
Push the paper tray completely into the printer.

There is a foreign object inside the printer.
Turn off the printer and remove the foreign object. Refer to the Xerox 
Support website, www.xerox.com/office/6140support, for assistance.

Symptom Reason/Action

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=tech&Language=english
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Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and see the 
corresponding solution to correct the problem. You can also print a demo page to more precisely 
determine the print-quality problem. For details, see Information Pages on page 126.

If the print quality does not improve after carrying out the appropriate action, contact Xerox Customer 
Support or your reseller.

Note: To enhance print quality, toner cartridges for many models of equipment have been 
designed to cease functioning at a predetermined point.

Symptom Cause Solution

Faded printouts / multiple 
colors faded.

The toner cartridges are not 
Xerox toner cartridges.

Verify that the toner cartridges (CMYK) 
meet specifications, and replace them if 
necessary.

The paper being used is outside 
the recommended specification 
range.

Replace the media with a recommend 
size and type, and confirm that your 
control panel / printer driver settings are 
correct. For details, see Usable Paper on 
page 52.

The paper is damp. Replace the paper.

The transfer belt unit is old or 
damaged.

Replace the transfer belt unit.

The high-voltage supply is 
defective.

For assistance, see the Xerox Support 
website:
www.xerox.com/office/6140support

Only one color is faded. Toner cartridge is empty or 
damaged.

Check the condition of the toner 
cartridge and replace it if necessary.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=tech&Language=english


Troubleshooting

Phaser 6140 Color Laser Printer
User Guide

136

Stray black dots or white areas 
(drop outs).

The paper is outside the 
recommended specification 
range.

Replace the paper with a recommended 
size and type, and confirm that your 
control panel / printer driver settings are 
correct. For details, see Usable Paper on 
page 52.

The transfer belt unit is old or 
damaged.

Replace the transfer belt unit.

The toner cartridges are not 
Xerox toner cartridges.

Verify that the toner cartridges meet 
specifications and replace them if 
necessary. For details, see Consumables 
on page 114.

• Vertical black or color 
streaks or multiple colored 
streaks or lines.

• Streaks in only one color.

• The transfer belt unit is old 
or damaged.

• The toner cartridges are not 
Xerox toner cartridges.

Verify that the toner cartridges meet 
specifications and replace them if 
necessary. For details, see Consumables 
on page 114.

There is a problem with the 
toner cartridge for that color.

Check the toner cartridge for damage 
and replace if necessary.

Recurring smudges. Dirt in the paper path. Printer several blank sheets until the 
smudges disappear.

The paper is outside the 
recommended specification 
range.

Replace the paper with a recommended 
size and type, and confirm that your 
control panel settings are correct. For 
details, see Usable Paper on page 52.

The transfer belt unit or fuser is 
old or damaged.

Check the condition of the transfer belt 
unit and the fuser and replace if 
necessary.

Symptom Cause Solution
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Toner smears when rubbed. The paper is damp. Replace the paper.

The paper is outside the 
recommended specification 
range, or the paper type setting 
is not correct.

Replace the paper with a recommended 
size and type and then confirm that 
your printer driver settings are correct. 
For details, see Usable Paper on 
page 52.

The toner cartridges are not 
Xerox toner cartridges.

Verify that the toner cartridges meet 
specifications and replace if necessary. 
For details, see Consumables on 
page 114.

The fuser is old or damaged. Replace the fuser.

Printed pages are blank. Two or more sheets may be 
feeding at once.

Remove the paper stack from the tray, 
fan it, then reinsert it.

The toner cartridges are not 
Xerox toner cartridges.

Verify that the toner cartridges meet 
specifications and replace if necessary. 
For details, see Consumables on 
page 114.

The transfer belt unit is old or 
damaged.

Replace the transfer belt unit.

The cable to the laser unit or 
controller is defective.

For assistance, see the Xerox Support 
website:
www.xerox.com/office/6140support

Hair-like marks appear in or 
around black half-tone printing. 
Shadows appear around areas 
of dense black printing.

The paper was left unwrapped 
for a long time (especially in a 
dry environment).

Replace the paper. Also, see Paper 
Storage Guidelines on page 51.

The paper is outside the 
recommended specification 
range.

Replace the paper with a recommended 
size and type and then confirm that 
your printer driver settings are correct. 
For details, see Usable Paper on 
page 52.

The transfer belt unit is old or 
damaged.

Replace the transfer belt unit.

Color around the edge of 
printing is incorrect.

The color registration is 
incorrect.

Adjust the color registration. For details, 
see Color Registration on page 143.

Colored dots are printed at 
regular intervals (about 28 
mm).

The imaging unit is dirty. Gently clean the imaging unit. For 
details, see Cleaning the Imaging Unit 
and Laser Lens on page 140.

Symptom Cause Solution

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=tech&Language=english
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Partial blanks, creased paper, or 
blotted printing.

The paper is damp. Replace the paper.

The paper is outside the 
recommended specification 
range.

Replace the paper with a recommended 
size and type. For details, see Usable 
Paper on page 52.

The transfer belt unit or the 
fuser is not installed correctly.

Reinstall the transfer belt unit or the 
fuser. For details, see the instruction 
sheets in the documentation packet 
that came with your printer.

The toner cartridges are not 
Xerox toner cartridges.

Verify that the toner cartridges meet 
specifications and replace if necessary. 
For details, see Consumables on 
page 114.

Condensation inside the printer 
causes partial blanks or creased 
paper.

Turn the printer on and leave it on for at 
least one hour to get rid of the 
condensation. If the problems still 
occurs, for assistance see the Xerox 
Support website:
www.xerox.com/office/6140support

Vertical blanks. The laser is being blocked. Remove the imaging unit and clean all 
debris from the laser lens with a lint-free 
cloth. For details, see Cleaning the 
Imaging Unit and Laser Lens on 
page 140.

The transfer belt unit or fuser is 
old or damaged.

Check the condition of the transfer belt 
unit and fuser, and replace as necessary.

The toner cartridges are not 
Xerox toner cartridges.

Verify that the toner cartridges meet 
specifications and replace if necessary.

Slanted printing. The paper guides in the trays 
are not set correctly.

Reset the paper tray guides. For details, 
see Loading Paper on page 55.

Horizontal bands, 
approximately 22 mm wide, 
appear vertically every 73 mm.

The imaging unit has been 
exposed to too much light; 
possibly from leaving the front 
door open too long.

Replace the imaging unit.

Symptom Cause Solution

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=tech&Language=english
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Colors are blurry or there is 
white area around objects.

Color-to-color alignment is not 
correct.

Perform an automatic color registration 
adjustment. For details, see Color 
Registration on page 143.

Symptom Cause Solution
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Cleaning the Imaging Unit and Laser Lens

If print quality becomes a problem and you are advised to clean the imaging unit and laser lens, follow 
these instructions.

Note: Do not use warm water or cleaning solvents to remove toner from your skin or clothing. This 
will set the toner and make it difficult to remove. If any toner gets on your skin or clothing, use a 
brush to remove the toner, blow it off, or wash it off with cold water and mild soap.

Caution: Do not expose the imaging unit to strong light, and minimize its exposure to light in 
general to five minutes or less if possible.

1. Switch off the printer at the power switch located on the left side of the printer toward the back.
2. Wait until the printer has cooled (about 40 minutes).
3. Remove Tray 1 and set it aside.
4. Open the printer by pressing the front cover button on the right side of the printer near the top.

5. Fold down the transfer belt unit, being careful not to touch its shiny surface.
6. Using a flashlight, inspect the gaps in the imaging unit and remove any paper debris from the area.

6140-023 6140-024
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7. Remove the imaging unit:

Caution: Do not drop or shake the imaging unit after removal because toner can spill from it.

Caution: Do not expose the imaging unit to any light source for more than five minutes. Prolonged 
exposure to light may damage the unit. Cover the imaging unit while it is exposed. Do not touch 
the shiny blue transfer belt unit. For details, see Internal Components on page 20 for location.

a. Turn the four peach-colored twist-locks to the left to unlock the imaging unit.

b. Grasp the imaging unit by its peach-colored pull tabs on the top edge and then pull the unit 
forward and up out of the printer.

c. Place the imaging unit on a flat surface and cover it with a sheet of paper to minimize its 
exposure to light.

8. Using a clean, dry, lint-free cloth or swab, clean all debris from the laser lens.

9. Check for and remove any debris around the imaging unit gears located on the left side of the unit.

4x
90º90˚

6140-025 6140-026

6140-042
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10. Reinstall the imaging unit:
a. Grasp the unit by its peach-colored pull-tabs on the top edge and install the unit in the printer. 

Make sure to insert the unit into the guides in the printer and then push the unit all the way 
back into the printer.

b. Turn the four twist-locks to the right to lock the unit.
11. Fold the transfer belt unit back into place and close the printer front cover.

6140-041
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Color Registration

This section includes:
• Enabling/Disabling Automatic Color Registration on page 143
• Performing an Automatic Color Registration Adjustment on page 143
• Performing a Manual Color Registration Adjustment on page 144

Color registration can be adjusted by the printer automatically if automatic adjustment is enabled, or 
you can manually adjust it. Color registration should be adjusted any time the printer is moved. You 
may also need to adjust the color registration if you are having printing problems. For details, see Print-
Quality Problems on page 135.

Enabling/Disabling Automatic Color Registration

Use the following procedure to enable or disable the automatic color registration adjustment feature.
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. Arrow down to Maintenance Mode and press OK.
4. Arrow down to Auto Regi Adj and press OK.
5. Do one of the following:

• To enable the feature, at On press OK.
• To disable the feature, arrow down to Off and press OK.

6. Press Menu to return to the main menu.

Performing an Automatic Color Registration Adjustment

Use the following procedure to perform automatic color registration adjustment.

Note: An automatic color registration adjustment is performed every time a new toner cartridge is 
installed.

1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. Arrow down to Maintenance Mode and press OK.
4. Arrow down to Adjust Color Regi and press OK.
5. At Auto Adjust, press OK.
6. At Are you sure? press OK to begin the calibration.

When the adjustment is complete, the printer control panel reads Ready.
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Performing a Manual Color Registration Adjustment

You can fine tune color registration by performing a manual adjustment. Manual color registration 
adjustment is a three-step process:
1. Printing the Color Registration Correction Chart on page 144.
2. Determining the Color Registration Values on page 144.
3. Entering Color Values on page 145.

Printing the Color Registration Correction Chart
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. Arrow down to Maintenance Mode and press OK.
4. Arrow down to Adjust Color Regi and press OK.
5. Arrow down to Color Regi Chart and press OK.

The Color Registration Chart prints.
6. Continue to Determining the Color Registration Values on page 144 to determine if an adjustment 

needs to be made.

Determining the Color Registration Values

The Color Registration Chart shows horizontal and vertical values for each color, Y (yellow), M 
(magenta), and C (cyan). Section 1 shows horizontal values, and Section 2 shows vertical values.

To determine the horizontal values:
1. In Section 1 of the Color Registration Chart, lines are displayed to the right of the color letters Y, M, 

and C. Some lines are straight and other lines are jagged. A value is listed next to each line. For 
each color, examine the lines and determine which one is the straightest. Refer to the enlarged 
illustration on the chart that gives an example of what to look for.

2. For each color, do one of the following:
• If zero (0) is the value nearest the straightest line, you do not need to adjust the color 

registration.
• If zero (0) is not the value nearest the straightest line, write down the number that is.

3. Proceed to determining the vertical values (below).

To determine the vertical values:
1. In Section 2 of the Color Registration Chart, columns of color are displayed. In the center of the 

columns is a wavy white column where there is no color. This column of white needs to be centered 
as closely as possible at 0. Refer to the enlarged illustration on the chart that gives an example of 
how to determine which number is closest to the center of the white band.

2. For each color, do one of the following:
• If zero (0) is the value closest to the middle of the white band, you do not need to adjust that 

color.
• If zero (0) is not the value closest to the middle of the white band, write down the number that 

is.
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3. If you need to make any horizontal or vertical adjustments, proceed to Entering Color Values on 
page 145.

Entering Color Values

Using the printer control panel, enter the values that you found in the Color Registration Correction 
Chart to make adjustments.
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. Arrow down to Maintenance Mode and press OK.
4. Arrow down to Adjust Color Regi and press OK.
5. Arrow down to Enter Number and press OK.
6. For setting the horizontal values, arrow down to Fast Scan and press OK.
7. Press the Up or Down Arrow button until the required value on the chart is selected, then press the 

Forward Arrow button once to move the cursor to the next value that requires adjustment.
8. When the horizontal adjustments are complete, press OK.
9. Print the chart again to check the values: press the Back Arrow button, press the Up Arrow button 

to select Color Regi Chart and then press OK to print the chart. The values you just changed should 
be shown as the new 0 point.

10. If 0 is not displayed next to the straight lines, examine the chart and determine additional 
correction values. Beginning with step 7, repeat the steps to continue making adjustments until 0 is 
next to the straight lines. The color registration adjustment is complete when the straightest Y, M, 
and C lines are next to the 0 line.

11. When satisfied that the horizontal adjustment is complete, press the Menu button to return to the 
main Menu screen.

12. For setting the vertical values, repeat steps 1 through 5 and then, at Slow Scan, press OK.
13. Press the Up or Down Arrow button until the required value on the chart is selected, then press the 

Forward Arrow button once to move the cursor to the next value that requires adjustment.
14. When the adjustments are complete, press OK.
15. Repeat step 9 to print and check the values.
16. If the columns of white are not centered on 0 (as much as possible), look at the chart and 

determine the new correction values. Beginning with step 7, repeat the steps to continue making 
adjustments until 0 is next to the column of white on the printed chart. The color registration 
adjustment is complete when the columns of white are centered as much as possible on 0.

17. When finished, press the Menu button to return to the main menu.
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Paper Jams

This section includes:
• Preventing Paper Jams on page 146
• Clearing Paper Jams on page 147

Preventing Paper Jams

To reduce the occurrence of paper jams, follow the guidelines and instructions in Supported Paper and 
Media on page 50. It includes paper-usage guidelines and instructions for properly loading paper in 
the trays.

To prevent paper and other media misfeeds and printer jams, keep in mind the following guidelines:
• Make sure that the paper used matches the printer’s specifications for each tray.
• Media should lie flat, especially on the leading edge.
• The printer is on a hard, flat, level surface.
• Store paper and other media in a dry location away from moisture and humidity.
• Always adjust the media guides in Tray 1 after inserting the media. A guide that is not properly 

adjusted can cause poor print quality, media misfeeds, and printer damage.
• Avoid using media that is folded, wrinkled, or excessively curled.
• Avoid double feeding (remove the media and fan the sheets—they may be sticking together).
• Do not load more than one type/size/weight of media in a tray at the same time.
• Do not overfill the trays.
• Do not allow the output tray to overfill; misfeeding may occur if you allow too many sheets of 

media to accumulate at one time).

Warning: When removing jammed paper, make sure that no pieces of torn paper are left in the 
printer. If a sheet of paper is wrapped around the heat roller, or when clearing a jammed paper 
that is difficult or impossible to see, do not try to remove it by yourself. Power OFF the printer using 
the power switch on the left side of the printer, toward the back, and then contact Support for 
additional assistance.

Warning: The fuser and the surrounding area are hot and can cause burns.
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Clearing Paper Jams

This section includes:
• When Long Paper Jams on page 147
• Clearing Jams at Tray 1 on page 147
• Clearing Jams at the Manual Feed Slot on page 148
• Clearing Jams at the Fuser on page 149
• Clearing Jams at the 250-Sheet Feeder on page 149
• Clearing Jams at the Duplex Unit on page 150

When Long Paper Jams

When long paper (longer than 356 mm) jams inside the printer, cut the paper as needed, then remove 
it in the proper way depending on the place that the paper jam occurs.

Caution: If it is difficult to open the front cover, do not force it. Turn off the printer using the power 
switch on the left side of the printer, toward the back. For additional assistance, refer to the Xerox 
Support website: www.xerox.com/office/6140support.

Clearing Jams at Tray 1
1. Pull the jammed paper gently out of the paper tray and then remove any remaining paper from 

the tray.

2. Close the paper tray and then press the front cover button and open the front cover.

Warning: Some components inside the printer, such as the fuser and surrounding area, are hot and 
can cause burns.

6140-033 6140-034

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=tech&Language=english
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3. Carefully remove any jammed paper in the printer. Confirm that there are no scraps of paper left 
inside.

Caution: Prolonged exposure to light may damage the imaging unit so do not leave the cover open 
for more than 5 minutes at a time.

4. Close the front cover.
5. Remove the tray from the printer and then carefully pull out any jammed paper remaining inside 

the printer.

6. Reinsert the tray into the printer.

Caution: Do not use excessive force on the tray; doing so could damage the tray or the inside of 
the printer.

Clearing Jams at the Manual Feed Slot
1. Pull Tray 1 out of the printer.
2. Remove any jammed or damaged paper in the tray and then close the tray.
3. Press the front cover button to open the cover.
4. Carefully remove any jammed paper in the printer. Make sure there are no torn pieces of paper 

inside the printer.

6140-035

6140-036
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5. Close the front cover.

Clearing Jams at the Fuser
Warning: Never touch a labeled area found on or near the heat roller in the fuser. You can get 
burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it by yourself to 
avoid injuries or burns. Switch off the printer immediately and wait 40 minutes for the fuser to cool.

Warning: When removing jammed paper, make sure that no torn pieces of paper are left in the 
printer. A piece of paper remaining in the printer can cause a fire. If a sheet of paper is wrapped 
around the heat roller, or a jammed sheet of paper is difficult to see, do not try to remove the 
paper. Turn off the printer using the power switch on the left side of the printer, toward the back. 
For additional assistance, refer to the Xerox Support website www.xerox.com/office/6140support.

Caution: Do not expose the Imaging Unit to any light source for more than 5 minutes. Prolonged 
exposure to light may damage the unit. Do not touch the shiny black transfer belt unit.

1. Press the front cover button on the side of the printer and open the printer cover.
2. Being careful not to touch the fuser itself, lift the levers at both sides of the fuser to open its front 

cover and then remove the jammed paper. If the paper is torn, remove any scraps of paper 
remaining inside the printer.

3. Put the fuser tabs back into place and then close the printer’s front cover.

Clearing Jams at the 250-Sheet Feeder
Note: Paper jammed in the lower tray can block the trays above it, preventing you from opening 
them. Look for the jammed paper sequentially, starting with the lowest tray.

1. Pull out the paper trays until you find the jammed paper.

6140-037
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2. Remove all jammed and creased paper from the tray.

3. Pull the jammed paper out carefully to avoid tearing it. If the paper is torn, remove the scraps.
4. Press the front cover button and open the printer cover. Confirm that there are no scraps of paper 

remaining inside the printer.

Caution: Prolonged exposure to light may damage the imaging unit.

Warning: Some components inside the printer, such as the fuser and surrounding area, are hot and 
can cause burns.

5. Close the printer cover and then reinsert the trays.

Caution: Do not use excessive force on the tray. Doing so could damage the tray or the inside of 
the printer.

Clearing Jams at the Duplex Unit
1. Press the front cover button and open the printer cover.

Warning: Some components inside the printer, such as the fuser and surrounding area, are hot and 
can cause burns.

Caution: Prolonged exposure to light may damage the imaging unit.

2. Gently pull out the jammed paper. If you cannot find the jammed paper, go to the next step.

6140-0296140-043

6140-030
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3. Lift up the duplex unit by the recessed slot provided and open the unit fully.

4. Remove the jammed paper and then confirm that there are no scraps of paper left inside the 
duplex unit or transfer belt unit.

5. Close the duplex unit and then close the printer cover.

Note: If you need to remove the entire duplex unit for some reason, after opening the printer’s 
front cover, press the front cover-release button again to release the duplex unit.

6140-031
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Printer Specifications

This chapter includes:
• Physical Specifications on page 154
• Environmental Specifications on page 155
• Electrical Specifications on page 156
• Performance Specifications on page 157
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Physical Specifications

Weights and Dimensions

Part Specifications

Printer Width: 400 mm (15.8 in.)
Depth: 457 mm (18.0 in.)
Height: 415.4 mm (16.3 in.)
Weight: 18.4 kg (40.57 lb.)

250-Sheet Feeder (optional) Width: 400 mm (15.8 in.)
Depth: 457 mm (18 in.)
Height: 108 mm (4.2 in.)
Weight: 4.2 kg (9.26 lb.)

Duplex Unit (optional) Width: 326.5 mm (12.9 in.)
Depth: 310 mm (12.2 in.)
Height: 153.5 mm (6.1 in.)
Weight: 1.2 Kg (2.65 lb.)
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Environmental Specifications

Temperature
• 10°–32°C (50°–90°F)

Relative Humidity
Note: Under extreme environment conditions (such as 10°C and 85%RH), defects can occur due to 
condensation approximately 30 minutes after the printer is turned on.

• 15–85% RH at 28°C (82°F)

Elevation
• For optimum performance, use the printer at elevations below 3,000 m (11,480 ft.).
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Electrical Specifications

Power Source
• 110–127 V, 50/60 Hz, 11 A or less
• 220–240 V, 50/60 Hz, 5 A or less

Power Consumption

AC 110–127 V / 220–240 V
• Power Saver Mode (Sleep Mode): 8 W or less
• Standby Mode: 50 W or less (fuser on)
• Continuous color printing: 280 W or less
• Continuous monochrome printing: 280 W or less

This printer does not consume electric power when the power switch is turned off even if the printer is 
connected to an AC outlet.
• ENERGY STAR qualified printer
• Default time to Power Saver is 30 minutes
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Performance Specifications

Item Specification

Warm-up time Power on: 30 seconds or less.
Recovery from Power Saver mode: 25 seconds or less.
(assume temperature of 22°C / 71.6°F)

Continuous print speed Color: 18 ppm
Black & White: 20 ppm

Note: Print speed may decrease due to paper type, 
size, and printing conditions, or image quality 
adjustment.

Duplex print speed
(Phaser 6140/ND configuration only)

Color: 18 ppm (Letter) / 17 ppm (A4)
Black & White: 21 ppm (letter) / 20 ppm (A4)

Resolution Standard: 600 x 600 dpi x 1-bit
Enhanced: 600 x 600 dpi x 4-bit (PostScript driver) / 5-bit (PCL 
driver)
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Regulatory Information

This chapter includes:
• Electromagnetic Interference on page 160
• Material Safety Data Sheets on page 162
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Electromagnetic Interference

Xerox has tested this product to electromagnetic emission and immunity standards. These standards 
are designed to mitigate interference caused or received by this product in a typical office 
environment.

United States (FCC Regulations)

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential environment. This equipment generates, uses, and can 
radiate radio frequency energy. If it is not installed and used in accordance with these instructions, it 
may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:
• Reorient or relocate the receiver.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected.
• Consult the dealer or an experienced radio/television technician for help.

Any changes or modifications not expressly approved by Xerox could void the user's authority to 
operate the equipment. To ensure compliance with Part 15 of the FCC rules, use shielded interface 
cables.

Canada (Regulations)

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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European Union

This product, if used properly in accordance with the user's instructions, is neither dangerous for the 
consumer nor for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this product can be obtained from Xerox.

The CE mark applied to this product symbolizes Xerox’s declaration of conformity with 
the following applicable Directives of the European Union as of the dates indicated:
• December 12, 2006: Low Voltage Directive 2006/95/EC
• December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC
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Material Safety Data Sheets

For Material Safety Data information regarding your Phaser 6140, go to:

North America: www.xerox.com/msds

European Union: www.xerox.com/environment_europe

For Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=msdsna&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=msdseu&Language=english
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=customersupport&Language=english
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Recycling and Disposal

This chapter includes:
• All Countries on page 163
• North America on page 163
• European Union on page 163
• Other Countries on page 163

All Countries

If you are managing the disposal of your Xerox product, please note that the product may contain 
lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact 
your local authorities. In the United States, you may also refer to the Electronic Industries Alliance 
website: www.eiae.org. Perchlorate Material: This product may contain one or more Perchlorate-
containing devices, such as batteries. Special handling may apply, please see 
www.dtsc.ca.gov/hazardouswaste/perchlorate.

North America

Xerox operates an equipment take back and reuse/recycle program. Contact your Xerox sales 
representative (1-800-ASK-XEROX) to determine whether this Xerox product is part of the program. For 
more information about Xerox environmental programs, visit www.xerox.com/environment or for 
recycling and disposal information, contact your local authorities.

Other Countries

Please contact your local waste authorities and request disposal guidance.

European Union

Some equipment may be used in both a domestic/household and a professional/business application.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6140&PgName=environmentna&Language=english
http://www.eiae.org
http://www.dtsc.ca.gov/hazardouswaste/perchlorate
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Domestic/Household Environment

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information.

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask you retailer for information.

Professional/Business Environment

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life datebook 
information.

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste stream.

Application of this symbol on your equipment is confirmation that you must 
dispose of this equipment in compliance with agreed national procedures.
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Information for Users on Collection and Disposal of Old Equipment and Used 
Batteries

Note for the Battery Symbol

These symbols on the products and/or accompanying documents mean 
that used electrical and electronic products and batteries should not be 
mixed with general household waste.

For proper treatment, recovery and recycling of old products and used 
batteries, please take them to applicable collection points, in accordance 
with your national legislation and the Directive 2002/96/EC and 
2006/66/EC.

By disposing of these products and batteries correctly, you will help to save 
valuable resources and prevent any potential negative effects on human 
health and the environment which could otherwise arise from inappropriate 
waste handling.

For more information about collection and recycling of old products and 
batteries, please contact your local municipality, your waste disposal service 
or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation.

For Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact 
your dealer or supplier for further information.

Information on disposal in other countries outside the European Union

These symbols are only valid in the European Union If you wish to discard 
these items, please contact your local authorities or dealer and ask for the 
correct method of disposal.

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by the 
Directive.

Removal

Batteries should only be replaced by a MANUFACTURER approved service 
facility.Hg
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Index

Numerics
250-sheet feeder

clearing paper jams at, 149
loading paper in, 59

2-sided printing, 87
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manual, 88

2-sided printing binding options, 87
2-sided printing guidelines, 87

A
Admin Menu, 99

B
billing meters

checking, 121
Billing Meters Menu, 98

C
card stock

printing from the manual feed slot, 83
printing from Tray 1, 82

card stock printing guidelines, 82
caution symbols, 15
CentreWare IS

accessing, 26, 116
accessing help for, 117
checking printer status in, 116

cleaning
imaging unit and laser lens, 140
printer exterior, 112
printer interior, 113

cleaning precautions (general), 112
color registration, 143

adjusting automatically, 143
adjusting manually, 144
determining values, 144
enabling or disabling automatic, 143
entering color values, 145

printing Color Registration Correction 
chart, 144

Configuration page, 25
control panel button functions, 21
control panel features and layout, 21
Control Panel Menu, 107
control panel menus, 95
control panel messages, 128
control panel password, 107
custom-size paper

creating for use with PCL driver, 85
creating for use with PostScript driver, 85
defining in the printer driver, 84
printing, 86
printing using PCL driver, 86
printing using PostScript driver, 86

D
Demo page

printing, 126
drivers

installing, 38
installing for Macintosh, 39
installing for Windows, 39

duplex unit
clearing paper jams at, 150
locating, 20

duplexing, 87

E
electrical safety, 10
electrical safety guidelines, 10
electrical specifications, 156
email alert commands, 119
email alerts

configuring, 118
enabling optional printer features, 44
envelope printing guidelines, 75
envelopes

printing, 75
printing from the manual feed slot, 77
printing from Tray 1, 76

environmental specifications, 155
Error History report

printing, 126
error messages, 129
extension cord use, 10
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F
fuser

clearing paper jams at, 149
locating, 20

G
Gateway address, 35
glossy paper

printing, 80
printing from the manual feed slot, 81
printing from Tray 1, 80

glossy paper printing guidelines, 80
ground connection terminal, 10

H
help resources, 27

I
imaging unit

cleaning, 140
locating, 20

information pages, 25, 27
Information Pages Menu, 97
information resources, 27

Installation Guide, 27
Quick Use Guide, 27
technical support, 27
video tutorials, 27

IP address
about, 34
assigning to printer, 34
assigning to printer automatically, 35
assigning to printer manually, 35
changing using CentreWare IS, 36
finding the printer’s, 37

L
label printing guidelines, 78
labels

printing from the manual feed slot, 79
printing from Tray 1, 79

laser safety, 10
Linux printer driver, 38
loading paper, 55

M
Macintosh printer driver, 38
Maintenance Mode Menu, 103
maintenance safety, 14
manual feed slot

clearing paper jams at, 148
loading paper in, 57
printing card stock from, 83
printing envelopes from, 77
printing glossy paper from, 81
printing labels from, 79

material safety data sheets, 162
menu lock, 107
Menu Map

printing, 25
menus

Admin, 99
Billing Meters, 98
Control Panel (lock), 107
Information Pages, 97
Maintenance Mode, 103
navigating in printer control panel, 96
Network Setup, 99
PCL Setup, 104
PostScript Setup, 106
System Setup, 101
Tray Settings, 108
USB Setup, 100

N
Network Mask address, 35
network settings

configuring, 34
Network Setup Menu, 99

O
Online Support Assistant, 126
operating environment, 155
operating system requirements, 38
operational safety, 12
operational safety guidelines, 12
optional printer features, 23
ozone release safety, 12

P
page counts

checking from the control panel, 121
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checking in CentreWare IS, 116
checking printer totals, 98

page layout options, 66, 68
paper

acceptable for use, 52
damaging to the printer, 51
loading in 250-sheet feeder, 59
loading in manual feed slot, 57
loading in Tray 1, 55
storing, 51
supported types, 50

paper jams, 146
clearing at the 250-sheet feeder, 149
clearing at the duplex unit, 150
clearing at the fuser, 149
clearing at the manual feed slot, 148
clearing at Tray 1, 147
clearing long paper, 147
preventing, 146

paper size
defining Custom Page Size in the PostScript 

driver, 84
setting for trays, 62

paper storage guidelines, 51
paper trays

loading paper in, 55, 59
paper type

setting for trays, 62
paper usage guidelines, 50
PCL printer driver, 38
PCL printer driver options, 68
PCL Setup Menu, 104
PostScript printer driver, 38
PostScript printer driver options (Macintosh), 70
PostScript printer driver options (Windows), 66
PostScript Setup Menu, 106
power consumption specifications, 156
power cord safety, 10
Power Saver Mode, 24

setting time for, 24
starting manually, 24
waking the printer up from, 24

power source specifications, 156
print jobs

checking status in CentreWare IS, 117
storing in memory, 92

printer
adding to Macintosh printer queue, 40
choosing a connection method for, 32
connecting, 32

connecting to a network, 32
connecting via USB, 33
managing, 116
moving, 123

printer clearance requirements, 31
printer configurations, 22
printer disposal, 163
printer driver defaults

setting for a shared network printer, 65
setting for Windows, 64

printer driver options (Macintosh), 70
printer driver options (Windows), 65
printer drivers

installing, 38
installing for Macintosh, 39
installing for Windows, 39

printer error messages, 126
printer features, 17

additional, 22
enabling optional for Linux, 47
enabling optional for Macintosh, 46
enabling optional for Windows PCL driver, 45
enabling optional for Windows PostScript 

driver, 44
optional, 23
standard, 22

printer information pages, 25, 27
printer installation and setup overview, 30
printer internal components, 20
printer location, 31
printer location safety guidelines, 12
printer parts, 18
printer performance specifications, 157
printer problems, 132
printer recycling, 163
printer safety requirements, 9
printer specifications, 153, 154
printer status

checking in CentreWare IS, 116
checking via email, 118
checking with PrintingScout, 117

printer status messages, 126
printer supplies

checking status in CentreWare IS, 116
printer weight, 154
printing, 49

a job stored in the printer’s memory, 92
envelopes, 75
envelopes using the PCL driver, 78
envelopes using the PostScript driver, 77
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labels, 78
on card stock, 82
on custom-size paper, 84, 86
on glossy paper, 80
Proof Print jobs, 93
Secure Print jobs, 91

printing 2-sided documents, 87
automatically, 88
manually, 88
manually from the manual feed tray, 89
manually from Tray 1, 88

PrintingScout
checking printer status with, 117
installing, 43

PrintingScout alerts, 126
print-quality problems, 135
Proof Print jobs

printing, 94
setting up, 93

R
RAM Disk, 22
recycling

printer, 163
supplies, 115

regulatory information
Canada, 160
Europe, 161
United States, 160

resource information, 27

S
safety, 9
safety guidelines

for performing printer maintenance, 14
for using printer supplies, 13

Secure Print jobs, 90
printing, 91
setting up, 90

sleep mode, 24
setting, 24
waking the printer up from, 24

specialty media, 75
specifications, 153
standard features, 22
supplies

ordering, 114
recycling, 115

supply status messages, 128
support information, 27
supported paper and media, 50
System Setup Menu, 101

T
TCP/IP, 34
technical support resources, 27
toner

ordering, 114
toner cartridge location, 20
Tray 1

clearing paper jams at, 147
loading paper in, 55
printing 2-sided documents manually 

from, 88
printing card stock from, 82
printing envelopes from, 76
printing glossy paper from, 80
printing labels from, 79

Tray 2
clearing jams at, 149
loading paper in, 59

Tray Settings Menu, 108
trays

setting paper size for, 62
setting paper type for, 62

troubleshooting, 125
paper jams, 146
printer problems, 132
print-quality problems, 135

troubleshooting tools, 126

U
unacceptable paper and media, 51
UNIX printer driver, 38
usable paper, 52
usage guidelines for paper, 50
USB Setup Menu, 100

W
Wake Up button, 21
waking the printer from Power Saver Mode, 24
Walk-Up Printing feature, 22
Web links

information, 27
Web resources, 127
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